Hybrid Equations (HyEQ) Toolbox v2.04
A Toolbox for Simulating Hybrid Systems in
MATLAB/Simulink®

Ricardo G. Sanfelice David A. Copp Pablo Nanez
University of California University of California Universidad de Los Andes
Santa Cruz, CA 95006/ Santa Barbara, CA 93109 Colombia

USA USA
May 17, 2017
Abstract

This note describes the Hybrid Equations (HyEQ) Toolbox implemented in MATLAB/Simulink for
the simulation of hybrid dynamical systems. This toolbox is capable of simulating individual and inter-
connected hybrid systems where multiple hybrid systems are connected and interact such as a bouncing
ball on a moving platform, fireflies synchronizing their flashing, and more. The Simulink implementation
includes four basic blocks that define the dynamics of a hybrid system. These include a flow map, flow
set, jump map, and jump set. The flows and jumps of the system are computed by the integrator system
which is comprised of blocks that compute the continuous dynamics of the hybrid system, trigger jumps,
update the state of the system and simulation time at jumps, and stop the simulation. We also describe
a “lite simulator” which allows for faster simulation.
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1 Introduction

To get started, a webinar introducing the HyEQ Toolbox is available at
http://www.mathworks.com/videos/hyeq-a-toolbox-for-simulation-of-hybrid-dynamical-systems-81992.html
A free two-step registration is required by Mathworks.

A hybrid system is a dynamical system with continuous and discrete dynamics. Several mathematical
models for hybrid systems have appeared in literature. In this paper, we consider the framework for hybrid
systems used in [IL 2 Bl 4], where a hybrid system #H on a state space R™ with input space R™ is defined by
the following objects:

e A set C CR™ x R™ called the flow set.

e A function f: R™ x R™ — R" called the flow map.
e Aset D CR"™ xR™ called the jump set.

e A function g: R™ x R™ — R"™ called the jump map.

We consider the simulation in MATLAB/Simulink of hybrid systems H = (C, f, D, g) written as

x = f(z,u) (x,u) € C
H: z, ueR™ yeR" vt = g(z,u) (x,u) € D (1)
y = hx)

The flow map f defines the continuous dynamics on the flow set C, while the jump map ¢ defines the
discrete dynamics on the jump set D. These objects are referred to as the data of the hybrid system H,
which at times is explicitly denoted as H = (C, f, D, g). We illustrate this framework in a simple, yet rich
in behavior, hybrid system.

Example 1.1 (bouncing ball system) Consider a model for a bouncing ball written as

f(x)::{f?y},C::{xeRz|x1>0} (2)
g(x):[_gxz],D:{IER2|x1§O,x2§O} (3)

where v > 0 is the gravity constant and A € [0,1) is the restitution coefficient. In this model, we consider
the ball to be bouncing on a floor at a height of 0. This model is re-visited as an example in Section [3] and
Section o

The remainder of this note is organized as follows. In Section 2] we describe how to install the HyEQ
Toolbox in MATLAB. In Section [3] we introduce the Lite HyEQ Simulator for solving hybrid systems
without inputs. In Section [d] we introduce the HyEQ Simulator implemented in Simulink for solving single
and interconnected hybrid systems with inputs. In Section [5] we work through several examples for the
simulation of single and interconnected hybrid systems. In Section [6] we give directions to where the
simulator files can be downloaded.


http://www.mathworks.com/videos/hyeq-a-toolbox-for-simulation-of-hybrid-dynamical-systems-81992.html

2 Installation

The following procedure describes how to install the Hybrid Equations (HyEQ) Toolbox in MATLAB. This
installation adds useful .m files to the MATLAB library and several blocks to the Simulink block library.
Steps for installation:

1. Download the HyEQ Toolbox from MATLAB Central or the author’s website at https://hybrid.
soe.ucsc.edu/software.

2. Extract all files and save in any place (except the root folder).
Open MATLAB and change the current folder to the folder where the install.m is located.

Type install in the command window and hit enter to run the file install.m.

ook W

Follow the on-screen prompts. Must answer yes to the question:
Add toolbox permanently into your startup path (highly recommended)? Y/E/N [Y]: y

6. Once installation has finished, close and then reopen MATLAB.

Now the HyEQ Toolbox is ready for use.
If you wish to uninstall the HyEQ Toolbox from MATLAB, simply run the tbclean.m file inside the
HyEQ_Toolbox_V2_04 folder, and follow the on-screen prompts.

3 Lite HYyEQ Simulator: A stand-alone MATLAB code for sim-
ulation of hybrid systems without inputs

One way to simulate hybrid systems is to use ODE function calls with events in MATLAB. Such an imple-
mentation gives fast simulation of a hybrid system.

In the lite HyEQ solver, four basic functions are used to define the data of the hybrid system H as in
(without inputs):

e The flow map is defined in the MATLAB function f.m. The input to this function is a vector with
components defining the state of the system x. Its output is the value of the flow map f.

e The flow set is defined in the MATLAB function C.m. The input to this function is a vector with
components defining the state of the system z. Its output is equal to 1 if the state belongs to the set
C or equal to 0 otherwise.

e The jump map is defined in the MATLAB function g.m. Its input is a vector with components defining
the state of the system x. Its output is the value of the jump map g.

e The jump set is defined in the MATLAB function D.m. Its input is a vector with components defining
the state of the system x. Its output is equal to 1 if the state belongs to D or equal to 0 otherwise.

Our Lite HyEQ Simulator uses a main function run.m to initialize, run, and plot solutions for the simu-
lation, functions f.m, C.m, g.m, and D.m to implement the data of the hybrid system, and HyEQsolver.m
which will solve the differential equations by integrating the continuous dynamics, & = f(z), and jumping by
the update law ™ = g(z). The ODE solver called in HyEQsolver.m initially uses the initial or most recent
step size, and after each integration, the algorithms in HyEQsolver.m check to see if the solution is in the
set C', D, or neither. Depending on which set the solution is in, the simulation is accordingly reset following
the dynamics given in f or g, or the simulation is stopped. This implementation is fast because it also does
not store variables to the workspace and only uses built-in ODE function calls.

Time and jump horizons are set for the simulation using TSPAN = [TSTART TFINAL] as the time interval
of the simulation and JSPAN = [JSTART  JSTOP] as the interval for the number of discrete jumps allowed.
The simulation stops when either the time or jump horizon, i.e. the final value of either interval, is reached.

The example below shows how to use the HyEQ solver to simulate a bouncing ball.


https://hybrid.soe.ucsc.edu/software
https://hybrid.soe.ucsc.edu/software
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Example 3.1 (bouncing ball with Lite HyEQ Solver) Consider the hybrid system model for the bouncing
ball with data given in Example

For this example, we consider the ball to be bouncing on a floor at zero height. The constants for the
bouncing ball system are v = 9.81 and A = 0.8. The following procedure is used to simulate this example in
the Lite HyEQ Solver:

e Inside the MATLAB script run.m, initial conditions, simulation horizons, a rule for jumps, ode solver
options, and a step size coefficient are defined. The function HyEQsolver.m is called in order to run
the simulation, and a script for plotting solutions is included.

e Then the MATLAB functions f.m, C.m, g.m, D.m are edited according to the data given above.

e Finally, the simulation is run by clicking the run button in run.m or by calling run.m in the MATLAB
command window.

Example code for each of the MATLAB files run.m, f.m, C.m, g.m, and D.m is given below.

% Matlab M—-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
% https://hybrid.soe.ucsc.edu/software

% http://hybridsimulator.wordpress.com/

% Filename: run_exl 2a.m

% Project: Simulation of a hybrid system (bouncing ball)

oo

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

o° o° o° o oe

function run_exl_ 2a

)

% initial conditions

x1_0 = 1;
x2_0 = 0;
x0 = [x1_0;x2_071;

[)

% physical variables

global gamma lambda

gamma = -9.81; % gravity constant
lambda = 0.8; % restitution coefficent
% simulation horizon

TSPAN=[0 10];

JSPAN = [0 20];

-
o
—
(0]
h
o
[

jumps
—-> priority for Jjumps

o o oo
=
[}
=
[0)
|
b

rule = 2 -> priority for flows

options = odeset ('RelTol’,le-6,’'MaxStep’,.1);

t j x] = HyEQsolver( @f_exl_2a,Qg_exl_2a,@C_exl1l_2a,@D_exl_2a,...
x0, TSPAN, JSPAN, rule, options) ;
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[)

% plot solution

figure(l) % position

clf

subplot (2,1,1), plotHarc(t,j,x(:,1));
grid on

ylabel ("x_1 position’)

subplot (2,1,2), plotHarc(t,j,x(:,2));
grid on

ylabel ("x_2 velocity’)

)

% plot phase plane

figure (2) % position

clf
plotHarcColor(x(:,1),3,x(:,2),t);
xlabel ("x_17)

ylabel ("x_2")

grid on

% plot hybrid arc
figure (3)
plotHybridArc(t, j, x)
xlabel (" 37)

ylabel ("t”)
zlabel (" x17)

function xdot = f_exl_2a(x)

https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/
Filename: f_exl 2a.m

o° o° o° o oe

% Project: Simulation of a hybrid system (bouncing ball)
% Description: Flow map

Copyright @ Hybrid Systems Laboratory (HSL),
Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

o° o° o° o oe

% state
x1l = x(1);
x2 = x(2);

global gamma

[)

% differential equations

xdot = [x2 ; gammal;
end
function [value] = C_exl_2a(x)

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
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Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Filename: C_exl 2a.m

Description: Flow set

Return 0 if outside of C, and 1 if inside C

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

x1l = x(1);
if x1 >= 0
value = 1;
else
value = 0;
end
end
function xplus = g_exl_2a(x)
% Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
% https://hybrid.soe.ucsc.edu/software
% http://hybridsimulator.wordpress.com/
% Filename: g_exl_2a.m
% Project: Simulation of a hybrid system (bouncing ball)
% Description: Jump map
% See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
% PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
% Copyright @ Hybrid Systems Laboratory (HSL),
% Revision: 0.0.0.3 Date: 05/20/2015 3:42:00
% state
x1l = x(1);
X2 = x(2);
global lambda
xplus = [-x1 ; -lambdax*x2];
end
function inside = D_exl_2a (x)

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
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o° oo

Filename: D_exl 2a.m

% Description: Jump set
% Return 0 if outside of D, and 1 if inside D
% See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
% PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
% Copyright @ Hybrid Systems Laboratory (HSL),
% Revision: 0.0.0.3 Date: 05/20/2015 3:42:00
x1l = x(1);
x2 = x(2);
1if (x1 <= 0 && x2 <= 0)
inside = 1;
else
inside = 0;
end
end

5

0\\\\\\\\mw

-5

x1
x2

i i i i i i i i i i
0.5 1 1.5 2 25 3 3.5 4 4.5 1.5 2 25 3 3.5 4 4.5
flows [t] flows [t]

1 5

**
0.571} :‘T****
% Lol R \*II JEEIR IR I
OF %k k ok ok ok ok ok ok ook ok ok bk ok ok ok ok ok ox “L*J&*
L*
ol P T N S T O S S N S S R N S S
0123 456 7 8 9 10111213 14 15 16 17 18 19 20 01 23 456 7 8 9 10111213 14 15 16 17 18 19 20
jumps [j] jumps [j]
(a) Height (b) Velocity

Figure 1: Solution of Example

A solution to the bouncing ball system from x(0,0) = [1,0]" and with TSPAN = [0 10], JSPAN =
[0 20], rule = 1, is depicted in Figure (height) and Figure (velocity). Both the projection onto ¢
and j are shown. Figure [2| depicts the corresponding hybrid arc for the position state.

For MATLAB files of this example, see Examples/Example_1.2.

3.1 Solver Function

The solver function HyEQsolver solves the hybrid system using three different functions as shown below.
First, the flows are calculated using the built-in ODE solver function ODE45 in MATLAB. If the solution
leaves the flow set C, the discrete event is detected using the function zeroevents as shown in Section [3.1.1
When the state jumps, the next value of the state is calculated via the jump map g using the function jump
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Figure 2: Hybrid arc corresponding to a solution of Example [3.1} height

as shown in Section [3.1.2

function [t J x] = HyEQsolver(f,qg,C,D,x0,TSPAN, JSPAN, rule,options,solver,E)
SHYEQSOLVER solves hybrid equations.

Syntax: [t Jj x] = HYEQSOLVER(f,g,C,D,x0,TSPAN,JSPAN, rule,options, solver, E)
computes solutions to the hybrid equations

\dot{x} = f(x,t,J) x \in C x"+ = g(x,t,3) x \in D

where x is the state, f is the flow map, g is the Jjump map, C is the
flow set, and D is the jump set. It outputs the state trajectory (t, ])
-> x(t,Jj), where t is the flow time parameter and j is the Jjump
parameter.

x0 defines the initial condition for the state.
TSPAN = [TSTART TFINAL] is the time interval. JSPAN = [JSTART JSTOP] is

the interval for discrete jumps. The algorithm stop when the first
stop condition is reached.

rule (optional parameter) - rule for jumps
rule = 1 (default) -> priority for jumps rule = 2 -> priority for
flows

options (optional parameter) - options for the solver see odeset f.ex.

o0 o0 o° O O O O O A A A° A A A A A O o o° o° o° o°

options = odeset ('RelTol’,le-6);
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options = odeset (' InitialStep’,eps);

solver (optional parameter. String) - selection of the desired ode
solver. All ode solvers are suported, exept for odel5i. See help
odeset for detailed information.

E (optional parameter) - Mass matrix [constant matrix | function_handle]
For problems:
E+x\dot{x} = f(x) x \in C
X"+ = g(x) x \in D
set this property to the value of the constant mass matrix. For

problems with time- or state-dependent mass matrices, set this
property to a function that evaluates the mass matrix. See help
odeset for detailed information.

Example: Bouncing ball with Lite HyEQ Solver

o° o° o° o oe

o o° o o° o° o° o° o°

o\

Consider the hybrid system model for the bouncing ball with data given in
Example 1.2. For this example, we consider the ball to be bouncing on a
floor at zero height. The constants for the bouncing ball system are
\gamma=9.81 and \lambda=0.8. The following procedure is used to

simulate this example in the Lite HyEQ Solver:

* Inside the MATLAB script run_exl_2.m, initial conditions, simulation
horizons, a rule for jumps, ode solver options, and a step size
coefficient are defined. The function HYEQSOLVER.m is called in order to
run the simulation, and a script for plotting solutions is included.

* Then the MATLAB functions f_exl_2.m, C_exl_2.m, g_exl_2.m, D_exl_2.m
are edited according to the data given below.

x Finally, the simulation is run by clicking the run button in
run_exl_2.m or by calling run_exl_2.m in the MATLAB command window.

For further information, type in the command window:

web (["Example_1_2.html’]);

o)
°

x1
X2
x0

%

TS
Js

o0 o° o° o° o° o° O° d° o° oP

Define initial conditions

_0 =1;
_0 = 0;
= [x1_0; x2_07;

Set simulation horizon
PAN [0 10];
PAN = [0 207;

Set rule for Jjumps and ODE solver options

Il
i

rule —> priority for Jjumps

Il
N

rule -> priority for flows

set the maximum step length. At each run of the
integrator the option ’"MaxStep’ 1is set to

(time length of last integration) *maxStepCoefficient.
Default value = 0.1
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rule = 1;

options odeset ('RelTol’,le-6, " MaxStep’, .1);
Simulate using the HYEQSOLVER script

Given the matlab functions that models the flow map, Jjump map,
flow set and Jjump set (f_exl_2, g_exl_2, C_exl_2, and D_exl_2
respectively)

o° o o oP

[t jJ x] = HYEQSOLVER( Q@f_exl_2,@g_ex1_2,0@C_ex1_2,@D_ex1_2,...
x0, TSPAN, JSPAN, rule, options, ' oded5");

[)

% plot solution

figure(l) % position

clf

subplot (2,1,1),plotflows (t, j,x(:,1))
grid on

ylabel ("x1")

subplot (2,1,2),plotjumps (t, j,x(:,1))
grid on

ylabel ("x1")

figure (2) % velocity

clf

subplot (2,1,1),plotflows(t, j,x(:,2))
grid on

ylabel (" x2")

subplot (2,1,2),plotjumps (t, J,x(:,2))
grid on
ylabel (" x2")

[)

% plot hybrid arc

figure (3)
plotHybridArc(t, j, x)
xlabel (" J7)

ylabel ("t’)

zlabel ("x17)

[)

% plot solution using plotHarc and plotHarcColor
figure (4) % position

clf

subplot (2,1,1), plotHarc(t,j,x(:,1));

grid on

ylabel ("x_1 position’)

subplot (2,1,2), plotHarc(t,j,x(:,2));

grid on

ylabel ("x_2 velocity’)

10
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[)

% plot a phase plane

figure (5) % position

clf

plotHarcColor (x(:,1),3,x(:,2),t);
xlabel ("x_1")

ylabel ("x_2")

grid on

o o° o o° o° d° o° o oP

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/
Filename: HYEQSOLVER.m
See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),
Revision: 0.0.0.4 Date: 04/6/2017 16:26:00

o® o o° o° oP

o® o o° o oP

if T“exist ('rule’,’var’)
rule = 1;
end

if "exist (‘options’,’var’)

options = odeset();
end
if exist ('E’,’var’) && “exist (’'solver’,’var’)
solver = 'odelbs’;
end
if "exist (’solver’,’var’)
solver = ’'odedb5’;
end
if Texist ('E’,’var’)
E = [1;
end

% mass matrix (i1f existent)
isDAE = false;
if "isempty (E)
isDAE = true;
switch isa (E,’ function_handle’)
case true % Function E (x)
M = E;
options = odeset (options,’Mass’,M,’ Stats’,’off’, ...
"MassSingular’,'maybe’,’MStateDependence’,’strong’, ...
"InitialSlope’, f_hdae (x0,TSPAN(1l)));
case false $ Constant double matrix
M = double (E);
options = odeset (options,’Mass’,M,’ Stats’,’off’, ...
"MassSingular’,'maybe’,’MStateDependence’, ' none’);
end
end

11



187 odeX = str2func (s
188 nargf = nargin (f)
189 nargg = nargin(g);
190 nargC = nargin(C)
191 nargD = nargin (D)
192

193

194

195 % simulation horizon
196 tstart = TSPAN(1l);
197 tfinal = TSPAN (end);
198 jout = JSPAN(1);

199 Jj = Jjout (end);

200

201 % simulate

202 tout = tstart;

203 [rx,cx] = size (x0);

204 1f rx == 1

205 xout = x0;

206 elseif cx ==

207 xout = x0.’;

208 else

209 error ('Error, x0 does not have the proper size’)

210 end

211

212 % Jump if Jjump is prioritized:

213 1f rule == 1

214 while (j<JSPAN (end))

215 % Check if value it is possible to jump current position
216 insideD = fun_wrap (xout (end, :).’,tout (end), j,D,nargD);
217 if insideD == 1

218 [J tout jout xout] = Jjump (g, j,tout, jout, xout,nargqg);
219 else

220 break;

221 end

222 end

223 end

224 fprintf (' Completed: $3.0£%%",0);
225 while (j < JSPAN(end) && tout (end) < TSPAN (end))

226 options = odeset (options,’Events’,@(t,x) zeroevents(x,t,j,C,D,...

227 rule, nargC,nargD));

228 % Check if it is possible to flow from current position

229 insideC = fun_wrap (xout (end, :) .’ ,tout (end), j,C,nargC) ;

230 if insideC == 1

231 if isDAE

232 options = odeset (options,’InitialSlope’, f(xout (end, :).’,tout (end)));
233 end

234 [t,x] = odeX(Q@(t,x) fun_wrap(x,t,]j,f,nargf), [tout (end) tfinall, ...
235 xout (end, :).’, options);

236 nt = length(t);

237 tout = [tout; t];

238 xout = [xout; x];

239 jout = [Jjout; Jj*ones(l,nt)’];

240 end

12
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insideD = fun_wrap (xout (end, :).’,tout (end), j,D,nargD) ;
if insideD == 1
[§J tout jout xout] = Jjump (g, Jj,tout, jout, xout, nargqg) ;
else
break;
end
end
else
[J tout jout xout] = Jjump (g, j,tout, jout, xout,nargqg) ;
end
end
fprintf (" \b\b\b\b%3.0f%%’ ,max (100%7j/JISPAN (end), 100xtout (end) /TSPAN (end) ) ) ;
end
t = tout;
X = xout;
J = jout;
fprintf (' \nDone\n’);
end
3.1.1 Events Detection
function [value,isterminal,direction] = zeroevents(x,t, j,C,D,rule,nargC,nargbD)
switch rule
case 1 % —> priority for Jjumps
isterminal (1) = 1; % InsideC
isterminal (2) = 1; % Inside(C \cap D)
isterminal (3) = 1; % OutsideC
direction(l) = -1; % InsideC
direction(2) = -1; % Inside(C \cap D)
direction(3) = 1; % OutsideC
case 2 % (default) -> priority for flows
isterminal (1) = 1; % InsideC
isterminal (2) 0; % Inside(C \cap D)
isterminal (3) = 1; % OutsideC
direction (1) -1; % InsideC
direction(2) = -1; % Inside(C \cap D)
direction(3) = 1; % OutsideC
end
insideC = fun_wrap(x,t, j,C,nargC);
insideD = fun_wrap(x,t, j,D,nargD);
outsideC = —-fun_wrap(x,t, j,C,nargC);

%Check if it is possible to jump

insideD = fun_wrap (xout (end, :).’,tout (end), j,D,nargD) ;
if insideD == 0

break;
else

if rule == 1

while (Jj<JSPAN (end))

[

% Check if it is possible to jump from current position

13
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value (l) = 2xinsideC;

value (2) = 2-insideC - insideD;
value (3) = 2+*outsideC;

end

3.1.2 Jump Map

function [Jj tout jout xout] = Jjump (g, j,tout, jout,xout,nargfun)
% Jump

j o= 3+1;

y = fun_wrap (xout (end, :) .’ ,tout (end), jout (end), g,nargfun) ;

% Save results

tout = [tout; tout (end)];

xout = [xout; v.’1;

jout = [Jout; JIl;

end

3.1.3 Function Wrapper

function xdelta = fun_wrap(x,t, j,h,nargfun)
$fun_wrap Variable input arguments function (easy use for users).

o o0 o° o° o° o° o° o

o° o° o° o o

o° o° o° o oe

fun_wrap (x,t, j,h,nargfun)

user, this script selects how the HyEQ solver should call that

function.

X: state

t: time

J: discrete time

h:

function handle

nargfun: number of input arguments of function h

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 01/28/2016 5:12:00

switch nargfun

end

case 1

xdelta = h(x);
case 2

xdelta = h(x,t);
case 3

xdelta = h(x,t,J);
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end

3.2 Software Requirements

In order to run simulations using the Lite HyEQ Simulator, MATLAB R13 or newer is required.

3.3 Configuration of Solver

Before a simulation is started, it is important to determine the needed integrator scheme, zero-cross detection
settings, precision, and other tolerances. Using the default settings does not always give the most efficient or
most accurate simulations. In the Lite HyEQ Simulator, these parameters are edited in the run.m file using

options = odeset(RelTol,le-6,MaxStep ,.1);.

3.4 Initialization

The Lite HyEQ Simulator is initialized and run by calling the function run.m. Inside run.m, the initial
conditions, simulation horizons TSPAN and JSPAN, a rule for jumps, and simulation tolerances are defined.
After all of the parameters are defined, the function HyEQsolver is called, and the simulation runs. See
below for sample code to initialize and run the bouncing ball example, Example

% initial conditions
= 1;

= 0;

x0 = [x1_0;x2_07;

% simulation horizon
TSPAN=[0,10];

JSPAN = [0,20];

rule for jumps

o° o° oe

rule = 1 —-> priority for jumps
rule = 2 —-> priority for flows
rule = 1;

options = odeset ('RelTol’,le-6,’'MaxStep’,.1);

3.5 Postprocessing and Plotting solutions

The function run.m is also used to plot solutions after the simulations is complete. See below for sample
code to plot solutions to the bouncing ball example, Example

)

% plot solution

figure(l) % position

clf

subplot (2,1,1),plotflows (t, j,x(:,1))
grid on

ylabel (" x1")

subplot (2,1,2),plotjumps(t, j,x(:,1))
grid on

ylabel (" x1")

figure (2) % velocity

clf

subplot (2,1,1),plotflows(t, j,x(:,2))
grid on

15



ylabel ("x2")

subplot (2,1,2),plotjumps (t, 3, x(:,2))
grid on

ylabel (" x2")

% plot hybrid arc
figure (2)
plotHybridArc(t, j, x)
xlabel (" 37)

ylabel ("t")

zlabel ("x1")

grid on
view(37.5,30)

The following functions are used to generate the plots:

e plotarc(t,j,x,L,jstar,modificatorF,modificatorJ resolution,DDD true3D): plots the hybrid time domain
(matrix) (¢, 7) versus the sate x (matrix) taking into account jumps j. If x is a matrix (n states), then
the hybrid time is plotted versus the rows or columns of the matrix, whichever line up. If ¢t and j
are a matrices, then each column of x will be plotted according to the hybrid time domain composed
for each column of ¢t and j. Depending on the input data, this function is capable of plotting several
types of figures, e.g., 2D, 3D, hybrid arcs with color, etc. Next, we list several functions that specialize
different types of plotting styles from plotarc. For more information, please type >> help plotarc or
>> helpwin plotarc in the command window.

e plotarc3(t,j,x,L,jstar,modificatorF,modificatorJ,resolution,true3D) is a version of plotarc that special-
izes in figures in 3D. For more information, please type >> help plotarc3 or >> helpwin plotarc3 in
the command window.

e plotflows(t,j,x,jstar,resolution): plots (in blue) the projection of the trajectory x onto the flow time
axis t. The value of the trajectory for intervals [¢;,¢;41] with empty interior is marked with * (in blue).
Dashed lines (in red) connect the value of the trajectory before and after the jump. Figure shows
a plot created with this function.

— plotflows(t,j,x,jstar): The plot is cut regarding the jstar interval (jstar = [j —initialj — final]).
— plotflows(t,j,x,jstar resolution): Also, a maximum resolution in between jumps is given by the

input variable resolution

e plotjumps(t,j,x,jstar,resolution): plots (in red) the projection of the trajectory x onto the jump time
j. The initial and final value of the trajectory on each interval [t;,t;41] is denoted by * (in red) and
the continuous evolution of the trajectory on each interval is depicted with a dashed line (in blue).
Figure shows a plot created with this function.

— plotjumps(t,j,x,jstar): The plot is cut regarding the jstar interval (jstar = [j —initialj — final]).
— plotjumps(t,j,x,jstar,resolution): Also, a maximum resolution in between jumps is given by the
input variable resolution

e plotHybridArc(t,j,x,jstar,resolution): plots (in blue and red) the trajectory x on hybrid time domains.
The intervals [t;,;11] indexed by the corresponding j are depicted in the ¢ —j plane (in red). Figure
shows a plot created with this function.

— plotHybridArc(t,j,x,jstar): The plot is cut regarding the jstar interval (jstar = [j — initialj —
final]).

— plotHybridArc(t,j,x,jstar resolution): Also, a maximum resolution in between jumps is given by
the input variable resolution

e plotHarc(t,j,x,jstar,modificatorF modificatorJ,resolution) is a function for plotting hybrid arcs (n states).
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— plotHare(t,j,x): plots the trajectory x versus the hybrid time domain (¢, 7). If  is a matrix, then
the time vector is plotted versus the rows or columns of the matrix, whichever line up.

— plotHarc(t,j,x,jstar): plots the trajectory x versus the hybrid time domain (¢, j), and the plot is
cut regarding the jstar interval (jstar = [finitial; Jfinal)-

— plotHarc(t,j,x,jstar,modificatorF,modificatorJ): ModificatorF and ModificatorJ are cell arrays
that contains the standard matlab ploting modificators (type >> help plotHarc or >> helpwin
plotHarc in the command window for more information).

e plotHarcColor(t,j,x,L,jstar,resolution) plots the trajectory x on hybrid time domain with color.

— plotHarcColor(t,j,x,L): plots the trajectory = (vector) versus the hybrid time domain (¢, ). The
hybrid arc is plotted with L data as color. The input vectors ¢, j, x, L must have the same
length.

— plotHarcColor(t,j,x,L,jstar): If a specific interval in j is required, jstar = [jinitial, J final] must be
provided. (type >> help plotHarcColor or >> helpwin plotHarcColor in the command window
for more information)

e plotHarcColor3D(t,j,x,L,jstar,modificator,resolution) plots an 3D hybrid arc with color.

— plotHarcColor3D(t,j,x,L) plots the trajectory x (3 states) taking into account the hybrid time
domain (¢, j). The hybrid arc is plotted with L data as color. The input vectors ¢, j, x, L must
have the same length and = must have three columns.

— plotHarcColor3D(t,j,x,L,jstar) If a specific interval in j is required, jstar = [jinitial, J finat] must
be provided.

— plotHarcColor3D(t,j,x,L,jstar,modificator) Modificator is a cell array that contains the standard
matlab ploting modificators (type >> help plotHarcColor3D or >> helpwin plotHarcColor3D in
the command window for more information).

4 HyEQ Simulator: A Simulink implementation for simulation
of single and interconnected hybrid systems with or without
inputs

The HyEQ Toolbox includes three main Simulink library blocks that allow for simulation of a hybrid system
H = (C, f,D,g) using either externally defined functions or embedded MATLAB functions, and a single
hybrid system or interconnected hybrid systems with inputs using embedded MATLAB functions. Figure
shows these blocks in the Simulink Library Browser.

Figure [4 shows a Simulink implementation for simulating a hybrid system with inputs using embedded
MATLAB functions. In this implementation, four basic blocks are used to define the data of the hybrid
system H:

e The flow map is implemented in an Embedded MATLAB function block executing the function f.m. Its
input is a vector with components defining the state of the system z, and the input w. Its output is
the value of the flow map f which is connected to the input of an integrator.

e The flow set is implemented in an Embedded MATLAB function block executing the function C.m. Its
input is a vector with components z~ and input u of the Integrator system. Its output is equal to 1 if
the state belongs to the set C' or equal to 0 otherwise. The minus notation denotes the previous value
of the variables (before integration). The value z~ is obtained from the state port of the integrator.

e The jump map is implemented in an Embedded MATLAB function block executing the function g.m.
Its input is a vector with components z~ and input u of the Integrator system. Its output is the value
of the jump map g.
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Figure 3: MATLAB/Simulink library blocks for Simulink implementation.

e The jump set is implemented in an Embedded MATLAB function block executing the function D.m. Its
input is a vector with components =~ and input u of the Integrator system. Its output is equal to 1 if
the state belongs to D or equal to 0 otherwise.

In our implementation, MATLAB .m files are used. The file initialization.m is used to define initial
variables before simulation. The file postprocessing.m is used to plot the solutions after a simulation is
complete. These two .m files are called by double-clicking the Double Click to... blocks at the top of the
Simulink Model (see Section for more information on these .m files and their use).

4.1 Specialized library for simulation of Cyber-Physical Systems

The HyEQ Toolbox includes a series of blocks that model elements of a cyber-physical system (CPS). Those
models are special instances of the hybrid systems blocks described above, particularly the blocks that use
embedded MATLAB functions. A cyber-physical system is given by the interconnection between a physical
process, the plant, a computer algorithm used for control, the controller; and the subsystems needed to
interconnect the plant and the controller, i.e., the interfaces, converters, and signal conditioners. Most of
the elements described in this section are presented in an extended form in [5].

In these notes, the temporal evolution of the variables of a cyber-physical system are captured using
dynamical models. In this document, we advocate that hybrid dynamical system models can be employed
to capture the behavior of cyber-physical systems. More precisely, the evolution of the continuous variables
is captured by differential equations while the evolution of the discrete variables is captured by difference
equations. These equations are typically nonlinear due to the complexity of the dynamics of those variables.
Furthermore, conditions determining the change of the continuous and discrete variables according to the
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said equations/inclusions can be conveniently captured by functions of the variables, inputs, and outputs.
In Figure[5] cyber and physical blocks are implemented within the HyEQ simulator.
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Figure 5: MATLAB/Simulink library blocks for Cyber-Physical Systems implementation.

4.1.1 Models of physical components

The physical components of a cyber-physical system include the analog elements, physical systems, and
the environment. Consider a model of a physical system given by a differential equation & = f(x,u) and
a output map y = h(x,u). Among the many possible models available, we capture the dynamics of the
physical components by using the hybrid systems framework by

&= f(z,u), C:={z|zeR"}, (4a)
$+ = g(‘r) = @7 D := ®7 (4b)
y = h(z,u) (4c)

Particularly, the model in can be implemented in the simulink block HSu in Figures |4)) and .
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4.1.2 Models of cyber components

The cyber components of a cyber-physical system include those in charge of performing computations,
implementing algorithms, and transmitting digital data over networks. The tasks performed by the code (at
the software level) and the logic-based mechanisms (at the circuit level) involve variables that only change
at discrete events, not necessarily periodically.

We denote the state variable of the cyber components by x. € T, where T C R™° is the state space.
The dynamics of 1 are defined by a difference equation with right-hand side defined by the map G.. We let
v € YV C R™¢ denote the input signals affecting the cyber components and ( € R"® to be the output defined
by the output function s, which is a function of the state x. and of the input v. With these definitions, the
general mathematical description of the cyber component is

Ij:Gc(zmv)v ¢ = H(CCC,U) (5)

In certain cases, it would be needed to impose restrictions on the state and inputs to the cyber component.
Such conditions can be modeled imposing that x. and v belong to a subset of their state space, namely,

(xe,v) €D. CYT XV (6)

The model of the cyber components is given by —@. Next, we provide specific constructions of models of
cyber components.

1) Pure Finite State Machines. A finite state machine (FSM) or deterministic finite automaton (DFA)
is a system with inputs, states, and outputs taking values from discrete sets that are updated at
discrete transitions (or jumps) triggered by its inputs. Then, given a FSM and an initial state ¢y € @,
a transition to a state ¢ = 0(qo,v) is performed when an input v € ¥ is applied to it. After the
transition, the output of the FSM is updated to #(g;). This mechanism can be captured by the
difference equation

" = dgv) ¢ ==rl (¢v)eQxT (7)
This model captures the dynamics the model of the cyber components in —@ with
Le = (, T:Qa szv GC:(Sa Dc:TXV

Note that there is no notion of time associated with the FSM model above. An example of this model
is presented in Example [5.8] In addition, the block FSM in Figure [5] can be used to model these type
of systems.

2) Analog-to-Digital Converters. Analog-to-digital converters (ADCs), or simply sampling devices, are
commonly used to provide measurements of the physical systems to the cyber components. Their main
function is to sample their input, which is usually the output of the sensors measuring the output y,
at a given periodic rate T and to make these samples available to the embedded computer. A basic
model for a sampling device consists of a timer state and a sample state. When the timer reaches the
value of the sampling time 77, the timer is reset to zero and the sample state is updated with the
inputs to the sampling device.

The model for the sampling device we propose has both continuous and discrete dynamics. If the timer
state has not reached T}, then the dynamics are such that the timer state increases continuously with
a constant, unitary rate. When T is reached, the timer state is reset to zero and the sample state is
mapped to the inputs of the sampling device. To implement this mechanism, we employ a timer state
Ts € R>o and a sample state m, € R™?. The input to the sampling device is denoted by v, € R™. The
model of the sampling devices is

#o=1, my= 0  when € 0,T7] (8)

A , mf= vy when 7,>T7 9)
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In practice, there exists a time, usually called the ADC acquisition time, between the triggering of
the ADC with the sampling device and the update of its output. Such a delay limits the number of
samples per second that the ADC can provide. Additionally, an ADC can store and process finite-
length digital words, which causes quantization. The model above omits effects such as acquisition
delays and quantization effects, but those can be incorporated if needed. In particular, quantization
effects can be added to the model in —@[) by replacing the update law for ms to m7 = round(vy),
where the function round is such that round(v;) is the closest number to vs that the machine precision
can represent.

Digital-to-Analog Converters. The digital signals in the cyber components need to be converted to
analog signals for their use in the physical world. Digital-to-analog converters (DACs) perform such
a task by converging digital signals into analog equivalents. One of the most common models for a
DAC is the zero-order hold model (ZOH). In simple terms, a ZOH converts a digital signal at its
input into an analog signal at its output. Its output is updated at discrete time instants, typically
periodically, and held constant in between updates, until new information is available at the next
sampling time. We will model DACs as ZOH devices with dynamics similar to —@D. Let 7, € Rxg
be the timer state, m;, € R"¢ be the sample state (note that the value of h indicates the number of
DACs in the interface), and v, € R" be the inputs of the DAC. Its operation is as follows. When
Tn < 0, the timer state is reset to 7, and the sample state is updated with v, (usually the output of the
Tmin’TmaX]

embedded computer), where 7, € | is a random variable that models the time in-between

communication instants and TMI% < 7MaX A model that captures this mechanism is given by

= —1, =0 when 75, € [TmianmaX] (10)
T}JLF = 7, m; = when 7 STmin (11)

Digital Networks. The information transfer between the physical and cyber components, or between
subsystems within the cyber components, might occur over a digital communication network. The
communication links bridging each of these components are not capable of continuously transmitting
information, but rather, they can only transmit sampled (and quantized) information at discrete time
instants. Combining the ideas in the models of the converters in the previous items, we propose a
model of a digital network link that has a variable that triggers the transfer of information provided
at its input, and that stores that information until new information arrives. We assume that the
transmission of information occurs at instants {t;}'_,, i* € NU {oo}, satisfying

TH™n <t —t; STE™™ Vie{1,2,...,i* —1}
where Tx™™ and T%™* are constants satisfying
T;[min, Tj:[max c [0’ OO}

and
* min * max
TN <Ty

* min

and ¢* is the number of transmission events, which might be finite or infinite. The constant 75

determines the minimum possible time in between transmissions while the constant T3\™** defines the

maximum amount of time elapsed between transmissions. In this way, a communication channel that

allows transmission events at a high rate would have T%™" small (zero for infinitely fast transmissions),

while one with slow data rate would have Tx™™ large. The constant Tx™®* determines how often
* IM1n * max

transmissions may take place. Note that the constants T3™" and T’y can be generalized to functions
so as to change according to other states or inputs.

At every t;, the information at the input vy of the communication link is used to update the internal
variable mp, which is accessible at the output end of the network and remains constant between
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communication events. This internal variable acts as an information buffer, which can contain not
only the latest piece of information transmitted but also previously transmitted information. A record
of the number of communication events is logged in the internal variable jy. At communication events,
the value of jy gets updated and remains constant in-between events. A mathematical model capturing
the said mechanism is given by

in= —1, ax =0, jy= 0  when 7y €[0,TH™] (12)

T € [T™, TR, mi = vy, jh=jn+1 when 75 <0 (13)

Note that the update law for 7y at jumps is given in terms of a difference inclusion, which implies
that the new value of 7y is taken from the set [T5™", T5™**]. The dimension of the states and the
input would depend on the type of components that connect to and from it, and also the size of data

transmitted and buffered. Similar to the models proposed for conversion, the model of the digital link
— does not include delays nor quantization, but such effects can be incorporated if needed.

4.2 The Integrator System

In this section we discuss the internals of the Integrator System shown in Figure [6]

1) P fxu) dot g
f
c CT dynamics I
2 > I > 2
Ca) >0 jump » 1; » LK_RE
b F— [x0] j
i " b
Jump logic - X
Co—Paww o0 o
g P - updatelaw P P %
t= it
Update logic 1Cx0

™
stop
P C
< Stop
@4—' D Simulation

X— Stop logic

Figure 6: Integrator System

4.2.1 CT Dynamics

This block is shown in Figure It defines the continuous-time (CT) dynamics by assembling the time
derivative of the state [t 7 x7]T. States ¢ and j are considered states of the system because they need to be
updated throughout the simulation in order to keep track of the time and number of jumps. Without ¢ and
7, solutions could not be plotted accurately. This is given by

t=1, j=0, = f(z,u) .

Note that input port 1 takes the value of f(z,u) through the output of the Embedded MATLAB function
block fin Figure [4
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Figure 7: CT dynamics

4.2.2 Jump Logic

This block is shown in Figure [§| The inputs to the jump logic block are the output of the blocks C' and D

indicating whether the state is in those sets or not, and a random signal with uniform distribution in [0, 1].

Figure |8 shows the Simulink blocks used to implement the Jump Logic. The variable rule defines whether

the simulator gives priority to jumps, priority to flows, or no priority. It is initialized in initialization.m.
The output of the Jump Logic is equal to one when:

e the output of the D block is equal to one and rule = 1,
e the output of the C block is equal to zero, the output of the D block is equal to one, and rule = 2,
e the output of the C block is equal to zero, the output of the D block is equal to one, and rule = 3,

e or the output of the C block is equal to one, the output of the D block is equal to one, rule = 3, and
the random signal r is larger or equal than 0.5.

Under these events, the output of this block, which is connected to the integrator external reset input,
triggers a reset of the integrator, that is, a jump of H. The reset or jump is activated since the configuration
of the reset input is set to “level hold”, which executes resets when this external input is equal to one (if the
next input remains set to one, multiple resets would be triggered). Otherwise, the output is equal to zero.

L rule=1: out=D
-ru e > rlule=2: out = D and ~C
rule=3: out = (D and ~C) or (D and C and r>0.5)
» other: out=0
20 >
2
NOT P 1
c 3 Jump
OR
AND > A
3 >=05 [0 P
r Compare Multiport
To Constant Switch

Figure 8: Jump Logic

4.2.3 Update Logic

This block is shown in Figure [0] The update logic uses the state port information of the integrator. This
port reports the value of the state of the integrator, [t j x']T, at the exact instant that the reset condition
becomes true. Notice that ™~ differs from x since at a jump, ™~ indicates the value of the state that triggers
the jump, but it is never assigned as the output of the integrator. In other words, “z € D” is checked using
2~ and if true, z is reset to g(z~,u). Notice, however, that u is the same because at a jump, u indicates the
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next evaluated value of the input, and it is assigned as the output of the integrator. The flow time ¢ is kept
constant at jumps and j is incremented by one. More precisely

tt=t—, jt=5+1,  zt =g ,u)

where [t~ j~ I’T]T is the state that triggers the jump.

update law

Figure 9: Update Logic

4.2.4 Stop Logic

This block is shown in Figure It stops the simulation under any of the following events:
e The flow time is larger than or equal to the maximum flow time specified by T.
e The jump time is larger than or equal to the maximum number of jumps specified by J.
e The state of the hybrid system x is neither in C nor in D.

Under any of these events, the output of the logic operator connected to the Stop block becomes one, stopping
the simulation. Note that the inputs C' and D are routed from the output of the blocks computing whether
the state is in C or D and use the value of x~.

Flow Horizon, T

et

t

Logical
Operator1

Jump Horizon, J

>
(2 ——» >=y —— P> or —»(1)
>

j stop
Logical
C Operator
: NOR

Figure 10: Stop Logic

4.3 Software Requirements

In order to run simulations of single hybrid systems using externally defined functions, MATLAB with
Simulink is required.

In order to run simulations using the HyEQ Simulator with embedded MATLAB functions, MAT-
LAB/Simulink and a supported ANSI, C, or C++ 32-bit compiler must be installed. We now briefly describe
how to install necessary compilers for Windows and Mac/Linux. For more information on supported com-
pilers, please visit http://www.mathworks.com/support/compilers/R2012b/win64.html,
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4.3.1 Configuration of HyEQ Simulator with embedded functions for Windows

For 32-bit Windows, the LCC compiler is included with MATLAB. First, open MATLAB and then locate
and choose a compiler for building MEX-files by typing

>> mex -setup

into the MATLAB command window. Then, follow the prompts as shown below.

>> mex -setup

Welcome to mex -setup. This utility will help you set up
a default compiler. For a list of supported compilers, see
http://www.mathworks.com/support/compilers/R2012a/win32.html

Please choose your compiler for building MEX-files:
Would you like mex to locate installed compilers [y]/n? y

Select a compiler:
[1] Lecc-win32 C 2.4.1

[0] None

Compiler: 1

Please verify your choices:
Compiler: Lcc-win32 C 2.4.1
Are these correct [y]/n? y

Done .

For 64-bit Windows, a C-compiler is not supplied with MATLAB. Before running the HyEQ Toolbox in
MATLAB/Simulink, please follow the following steps:

1. If you don’t have Microsoft .NET Framework 4 on your computer, download and install it from http:
//www.microsoft.com/en-us/download/details.aspx7id=17851.

2. Then download and install Microsoft Windows SDK from http://www.microsoft.com/en-us/download/
details.aspx?71d=8279.

3. Then perform the steps outlined above for 32-bit Windows to setup and install the compiler.

As of October 10, 2013, when installing the toolbox in Windows 8, please follow the next steps.

1. If you don’t have Microsoft .NET Framework 4 on your computer, download and install it from http:
//www.microsoft.com/en-us/download/details.aspx?id=8279.

2. Then download and install Microsoft Windows SDK

e If you don’t have Visual C++ 2010 SP1 installed on your computer:

— Download and install Microsoft Windows SDK 7.1 fromhttp://www.microsoft.com/en-us/
download/details.aspx?displaylang=en&id=4422

— Apply the following patch from Microsoft onto the SDK 7.1 installation: http://www.
microsoft.com/en-us/download/details.aspx?displaylang=en&id=4422
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e If you have Visual Visual C++ 2010 SP1 or its redistributable packages installed on your com-
puter:

— Uninstall the Visual C++ 2010 redistributable packages, both x64 and x86 versions. This
can be done from Control Panel / Uninstall Programs Menu.

— Download and install Microsoft Windows SDK 7.1 from http://www.microsoft.com/en-us/
download/details.aspx?displaylang=en&id=4422

— Apply the following patch from Microsoft onto the SDK 7.1 installation: http://www.
microsoft.com/en-us/download/details.aspx?displaylang=en&id=4422

— Reinstall the Visual C++ 2010 redistributable packages:
x86 version: http://www.microsoft.com/en-us/download/details.aspx?id=5555
x64 version: http://www.microsoft.com/en-us/download/details.aspx?id=14632

3. Then perform the steps outlined above for 32-bit Windows to setup and install the compiler.

4.3.2 Configuration of HyEQ Simulator with embedded functions for Mac/Linux

From a terminal window, check that the file gcc is in the folder /usr/bin. If it is not there, make a symbolic
link. You might require to install the latest version of Xcode first. In order to generate a symbolic link
for gee, that MATLAB can find to compile the simulation files (see http://www.mathworks.com/support/
sysreq/previous_releases.html), change folder to /usr/bin and then

sudo 1n -s gcc gcc-4.2

Then, it should be possible to setup the gcc compiler in matlab as follows:
>> mex -setup

Options files control which compiler to use, the compiler and link command
options, and the runtime libraries to link against.

Using the ’mexsh -setup’ command selects an options file that is
placed in ~/.matlab/R2013b and used by default for ’mexsh’. An options
file in the current working directory or specified on the command line

overrides the default options file in ~/.matlab/R2013b.

To override the default options file, use the ’mexsh -f’ command
(see ’mexsh -help’ for more information).

The options files available for MEX are:

The options files available for mexsh are:
1: /Applications/MATLAB_R2013b.app/bin/mexopts.sh :
Template Options file for building MEX-files
0: Exit with no changes
Enter the number of the compiler (0-1): 1
Overwrite ~/.matlab/R2013b/mexopts.sh ([yl/n)?7: Y

/Applications/MATLAB_R2013b.app/bin/mexopts.sh is being copied to
/SOME_FOLDER/mexopts.sh

26


http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=4422
http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=4422
http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=4422
http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=4422
http://www.microsoft.com/en-us/download/details.aspx?id=5555
http://www.microsoft.com/en-us/download/details.aspx?id=14632
http://www.mathworks.com/support/sysreq/previous_releases.html
http://www.mathworks.com/support/sysreq/previous_releases.html

At this point, it is possible to check if the gcc is properly setup by testing any of the Simulink examples

with embedded functions (see Figure [3]) (e.g., Examples or [5.6).

If an error regarding “gmake” similar to “No supported compiler or SDK was found” and/or a warning
“no such sysrooot directory: 'Developer/SDKs/MacOSX10.X.sdk'” is shown when compiling, please consider
the following procedure.

A. For Matlab 2013b and previous:

The compiler can not find the appropriate path. It is necesary to change some lines in the file
“mexopts.sh” (copied previously in the folder “SOME_FOLDER”) .

First, locate the Xcode-SDK in your hard drive. Open a terminal window and execute the following
command

xcodebuild -version -sdk macosx10.9 Path

which returns the location of MacOSX10.9.sdk, denoted here as SDK_FOLDER. Now, in the MATLAB
command window locate the file “mexopts.sh” by typing

cd /SOME_FOLDER/
Then, open the file
edit mexopts.sh

and edit the lines

— SDKROOT=’/Developer/SDKs/Mac0SX10.X.sdk’
to

SDKROOT=’SDK_FOLDER’

and
— MACOSX_DEPLOYMENT_TARGET=’10.X"

to

MACOSX_DEPLOYMENT_TARGET="10.9’

Now, it is possible to test if the compiler works. If the following error appears “unknown type name ’charl6_t’,”
some flags must be changed to avoid this problem. It is required to add -Dchar16_t=UINT16_T and
-std=c++11 to the flags CFLAGS and CFLAGS respectively, e.g., change

— CFLAGS="-fno-common -no-cpp-precomp -arch $ARCHS -isysroot $SDKROOT
-mmacosx-version-min=$MACOSX_DEPLOYMENT_TARGET"

to

CFLAGS="-fno-common -no-cpp-precomp -arch $ARCHS -isysroot $SDKROOT
-mmacosx-version-min=$MACOSX_DEPLOYMENT_TARGET -Dchar16_t=UINT16_T"

and

— CXXFLAGS="-fno-common -no-cpp-precomp -fexceptions -arch $ARCHS -isysroot $SDKROOT
-mmacosx-version-min=$MACOSX _DEPLOYMENT_TARGET"

to

CXXFLAGS="-fno-common -no-cpp-precomp -fexceptions -arch $ARCHS -isysroot $SDKROOT
-mmacosx-version-min=$MACOSX_DEPLOYMENT_TARGET -std=c++11"

Finally, restart matlab and test any of the aforementioned Simulink examples. for more information
visit http://www.mathworks . com/matlabcentral/answers/121315-how-to-set—the-c—compiler—of-matlab2013a-in-osx—-10-9
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B. For Matlab 2014b and newer.

First, locate the Xcode-SDK in your hard drive. It may be SDK 10.9, 10.10, 10.11, here we are going
to denote it as 10.X. Open a terminal window and execute the following command

xcodebuild -version -sdk macosx10.X Path

which returns the location of MacOSX10.X.sdk. We are interested in the last portion of the path,
specifically after /Applications/Xcode.app/.Contents/Developer/, denoted here as SDK_FOLDER.
Now, locate and edit the following files

/Applications/MATLAB_R20177.app/bin/maci6é4/mexopts/clang_maci64.xml
/Applications/MATLAB_R20177.app/bin/maci64/mexopts/clang++_maci64.xml

Inside those files there are the lines

<dirExists name="$$/Platforms/Mac0SX.platform/Developer/SDKs/Mac0SX10.10.sdk" />
<cmdReturns name="find $$ -name Mac0SX10.10.sdk" />

edit (or add below those lines) the lines

— <dirExists name="$$SDK\_FOLDER" />
and

— <cmdReturns name="find $$ -name Mac0SX10.X.sdk" />

Finally, restart matlab and test any of the aforementioned Simulink examples. for more information
visit https://bitbucket.org/d2d-development/d2d-software/issues/46/xcode-7-on-osx-with-matlab-r2015a-b

4.4 Configuration of Integration Scheme

Before a simulation is started, it is important to determine the needed integrator scheme, zero-cross de-
tection settings, precision, and other tolerances. Using the default settings does not always give the most
efficient or most accurate simulations. One way to edit these settings is to open the Simulink Model, select
Simulation>Configuration Parameters>Solver, and change the settings there. We have made this simple
by defining variables for configuration parameters in the initialization.m file. The last few lines of the
initialization.m file look like that given below.

%$configuration of solver
RelTol = 1le-8;
MaxStep = .001;

In these lines, “RelTol = 1e-8” and “MaxStep = .001” define the relative tolerance and maximum step
size of the ODE solver, respectively. These parameters greatly affect the speed and accuracy of solutions.

4.5 Initialization

When the block labeled Double Click to Initialize at the top of the Simulink Model is double-clicked, the
simulation variables are initialized by calling the script initialization.m. The script initialization.m
defines the initial conditions by defining the initial values of the state components, any necessary parameters,
the maximum flow time specified by 7', the maximum number of jumps specified by J, and tolerances used
when simulating. These can be changed by editing the script file initialization.m. See below for sample
code to initialize the bouncing ball example, Example

% initialization for bouncing ball example

clear all
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% initial conditions

x0 = [1;0];

% simulation horizon

T = 10;

J = 20;

% rule for jumps

% rule = 1 -> priority for jumps

$ rule = 2 —-> priority for flows

% rule = 3 -> no priority, random selection when simultaneous conditions
rule = 1;

$configuration of solver
RelTol = 1le-8;

It is important to note that variables called in the Embedded MATLAB function blocks must be added as
inputs and labeled as “parameters”. This can be done by opening the Embedded MATLAB function block
selecting Tools>Edit Data/Ports and setting the scope to Parameter.

After the block labeled Double Click to Initialize is double-clicked and the variables initialized, the
simulation is run by clicking the run button or selecting Simulation>Start.

4.6 Postprocessing and Plotting solutions

A similar procedure is used to define the plots of solutions after the simulation is run. The solutions can
be plotted by double-clicking on the block at the top of the Simulink Model labeled Double Click to Plot
Solutions which calls the script postprocessing.m. The script postprocessing.m may be edited to include
the desired postprocessing and solution plots. See below for sample code to plot solutions to the bouncing
ball example, Example [5.1] The functions used to generate the plots are described in Section [3.5

$postprocessing for the bouncing ball example
% plot solution

figure (1)

clf

subplot (2,1,1),plotflows (t, j, X)
grid on

ylabel ("x")

subplot (2,1,2),plotjumps (t, j, X)
grid on

ylabel ("x")

% plot hybrid arc

figure (2)

plotHybridArc(t, j, x)
xlabel (" j7)

ylabel ("t”)

zlabel (" x")

grid on

view(37.5,30)

5 Examples
The examples below illustrate the use of the Simulink implementation above.

Example 5.1 (bouncing ball with input) For the simulation of the bouncing ball system with a constant
input and regular data given by
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f(z,u) : [ } {(z,u) eER* xR | 1 > u} (14)

g(x,u)::[ >\UC2] D:={(z,u) eR*xR |21 <u, 22 <0} (15)

where v > 0 is the gravity constant, u is the input constant, and A € [0,1) is the restitution coefficient. The
MATLAB scripts in each of the function blocks of the implementation above are given as follows. An input
was chosen to be u(t,j) = 0.2 for all (¢,5). The constants for the bouncing ball system are v = 9.81 and
A=0.8.

The following procedure is used to simulate this example using the model in the file Example_1_2a.slx:

Example_1_2a.slx is opened in MATLAB/Simulink.

The Embedded MATLAB function blocks f, C, g, D are edited by double-clicking on the block and
editing the script. In each embedded function block, parameters must be added as inputs and defined
as parameters by selecting Tools>Edit Data/Ports, and setting the scope to Parameter. For this
example, gamma and lambda are defined in this way.

The initialization script initialization.m is edited by opening the file and editing the script. The
flow time and jump horizons, T" and J are defined as well as the initial conditions for the state vector,
xg, and input vector, ug, and a rule for jumps, rule.

The postprocessing script postprocessing.m is edited by opening the file and editing the script. Flows
and jumps may be plotted by calling the functions plotflows and plotjumps, respectively. The hybrid
arc may be plotted by calling the function plotHybridArc.

The simulation stop time and other simulation parameters are set to the values defined in initialization.m
by selecting Simulation>Configuration Parameters>Solver and inputting T, RelTol, MaxStep,
etc..

The masked integrator system is double-clicked and the simulation horizons and initial conditions are
set as desired.

The block labeled Double Click to Initialize is double-clicked to initialize variables.
The simulation is run by clicking the run button or selecting Simulation>Start.

The block labeled Double Click to Plot Solutions is double-clicked to plot the desired solutions.

Flow map
function xdot = f_exl_2a(x)

o o

o° o oe

o° o° o

oo

o° o° o° o° oP°

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Filename: f_exl 2a.m

Project: Simulation of a hybrid system (bouncing ball)
Description: Flow map

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00
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Figure 11: Solution of Example
% state
x1l = x(1);
x2 = x(2);

global gamma

% differential equations

xdot = [x2 ; gammal;
end
Flow set
function [value] = C_exl_2a(x)
% Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory
% https://hybrid.soe.ucsc.edu/software
% http://hybridsimulator.wordpress.com/
% Filename: C_ex1l_2a.m

Description: Flow set
Return 0 if outside of C, and 1 if inside C

o° o o

o

% See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
% PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
% Copyright @ Hybrid Systems Laboratory (HSL),
% Revision: 0.0.0.3 Date: 05/20/2015 3:42:00
x1l = x(1);
if x1 >= 0
value = 1;
else
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Figure 12: Hybrid arc corresponding to a solution of Example [5.1} height

value = 0;
end
end
Jump map
function xplus = g_exl_2a(x)

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Filename: g_exl_2a.m

o® o° o° o° oP

Project: Simulation of a hybrid system (bouncing ball)
Description: Jump map

o° o o

o°

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

o° o° o° o o

% state
x1l = x(1);
x2 = x(2);

global lambda
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xplus = [-x1 ; -lambdax*x2];
end

Jump set
function inside = D_exl_2a(x)

% Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

% Filename: D_exl_2a.m

% Description: Jump set

% Return 0 if outside of D, and 1 if inside D

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

o° o° o° o° oP°

x1l = x(1);

x2 = x(2);

1f (x1 <= 0 && x2 <= 0)
inside = 1;

else
inside = 0;

end

end

A solution to the bouncing ball system from x(0,0) = [1,0]T and with T = 10,J = 20, rule = 1, is
depicted in Figure (height) and Figure (velocity). Both the projection onto ¢t and j are shown.
Figure [12| depicts the corresponding hybrid arc for the position state.

These simulations reflect the expected behavior of the bouncing ball model. Note the only difference
between this example and the example of a bouncing ball without a constant input is that, in this example,
the ball bounces on a platform at a height of the chosen input value 0.2 rather than the ground at a value
of 0.

For MATLAB/Simulink files of this example, see Examples/Example_1.2a.

Example 5.2 (alternate way to simulate the bouncing ball)

Consider the bouncing ball system with a constant input and regular data as given in Example[5.1} This
example shows that a MATLAB function block, such as the jump set D, can be replaced with operational
blocks in Simulink. Figure [13| shows this implementation. The other functions and solutions are the same
as in Example

For MATLAB/Simulink files of this example, see Examples/Example_1.3 and Examples/Example_1.4.

o

Example 5.3 (vehicle following a track with boundaries) Consider a vehicle modeled by a Dubins vehicle
model traveling along a given track with state vector z = [¢1, &2, &3] T with dynamics given by 51 = ucosés,
Sg = usinés, and 53 = —&3+7r(q). The input w is the tangential velocity of the vehicle, £, and &3 describe the
vehicle’s position on the plane, and {3 is the vehicle’s orientation angle. Also consider a switching controller
attempting to keep the vehicle inside the boundaries of a track given by {(&1,&2) : —1 < & < 1}. A state
q € {1,2} is used to define the modes of operation of the controller. When ¢ = 1, the vehicle is traveling to
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Figure 13: Simulink implementation of bouncing ball example with operator blocks

the left, and when g = 2, the vehicle is traveling to the right. A logic variable r is defined in order to steer
the vehicle back inside the boundary. The state of the closed-loop system is given by x := [¢T ¢]T. A model
of such a closed-loop system is given by

ucos(&3)
- usin(€s) 3 g=1
few = || o= { F IS, (16
C = {Ew)eRP x{L2 xR |(E<lg=2or (&> -1g=1)}, (17)
S a<-1 g=1
g(&u) = ¢ : (18)
D = {(&ueR x{L,2} xR | (& >1,g=2)or (& <—1,g=1)} (19)

The MATLAB scripts in each of the function blocks of the implementation above are given as follows.
The tangential velocity of the vehicle is chosen to be u = 1, the initial position on the plane is chosen to be
(§1,&2) = (0,0), and the initial orientation angle is chosen to be &3 = 7 radians.

Flow map
function xdot =

f(x, u)
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Matlab Function Author: Ricardo Sanfelice

Project: Simulation of a hybrid system (Vehicle Traveling on a Track)

Name: f.m
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Description: Flow map
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Figure 14: Solution of Example [5.3

Version: 1.0
Required files: -

o° o° o

5555555555555 5555555555555 5555555555555 5555555555555 555555555%5%5%5%5%5%5%%%

xtemp = zeros(4,1);

xtemp = X;

X = Xtemp;

% state

xil = x(1); $x-position

x1i2 = x(2); $y-position

xi3 = x(3); %$orientation angle
q = x(4);

g =1 ——> going left
g = 2 —-—> going right

o° oo

if g==1

r = 3%pi/4;
elseif g ==

r = pi/4;
else

r = 0;
end

)

% flow map: xidot=f (xi,u);

xildot = uxcos(xi3); Stangential velocity in x-direction
xi2dot = uxsin(xi3); S%tangential velocity in y-direction
xi3dot = -xi3 + r; $angular velocity

qgdot = 0;

xdot = [xildot;xi2dot;xi3dot;gdot];
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Flow set
function v = C(x, u)

5555555555555 5555555555555 5555555555555 5555555555555555%55%555%5%5%5%%%
Matlab Function Author: Ricardo Sanfelice

o

o° oo

Project: Simulation of a hybrid system (Vehicle Traveling on a Track)

o\

o\

Name: C.m

o\

Description: Flow set

o oo

o\°

Version: 1.0
Required files: -
5555555555555 5555555555 55%555555%5555%5%555%%55555%555%%5%5555%5%5%55%%5%5%53%%5%5%5%%%

o\

xtemp = zeros (4,1);
xXtemp = x;
X = Xtemp;
% state
xil = x(1); $x-position
xi2 = x(2); Sy-position
xi3 = x(3); %$orientation angle
q = x(4);
$ q =1 ——> going left
% g = 2 ——> going right
if ((xil < 1) && (g == 2)) || ((xi1 > -1) && (g == 1)) % flow condition
v =1; % report flow
else
v = 0; % do not report flow
end
Jump map
function xplus = g(x, u)

5555555555555 5555555555555555555555555555%555555555%55555555%55555%5%%%5%%%
Matlab Function Author: Ricardo Sanfelice

o° o

o

Project: Simulation of a hybrid system (Vehicle Traveling on a Track)

o

Name: g.m

o° oo

o\

Description: Jump map

o\

o

Version: 1.0
Required files: -
B 55555555 T 5555555555555 555555555 HT555%5%5%%

o\

xtemp = zeros(4,1);
Xtemp = x;
X = Xtemp;
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31

% state

xil = x(1); $x-position

xi2 = x(2); $y-position

xi3 = x(3); %$orientation angle
q = x(4);

g =1 —-——> going left
g = 2 —-—> going right
xilplus=xil;
xi2plus=xi2;
xi3plus=xi3;

aplus=q;

o° oo

% jump map

if ((xi1 >= 1) && (g == 2)) || ((xil <= -1) && (g == 1))
gplus = 3-q;
else
gplus = g;
end
xplus = [xilplus;xi2plus;xi3plus;gplus];
Jump set
function v = D(x, u)

5555555555555 55555555 5555555555555 555555555555555%5555555%555555%5%5%5%%%
Matlab Function Author: Ricardo Sanfelice

Project: Simulation of a hybrid system (Vehicle Traveling on a Track)
Name: D.m

Description: Jump set

Version: 1.0

Required files: -
5555555555555 5555555555555 5555%55%%%

o° o° o© o o° J° A° o° o o

xtemp = zeros(4,1);
xtemp = X;
X = Xtemp;

% state
xil = x(1); $x-position
x12 = x(2); $y-position
xi3 = x(3); %$orientation angle
q = x(4);

$ g =1 ——> going left

$ g = 2 ——> going right

if ((xil >= 1) && (g == 2)) || ((xil <= -1) && (g == 1)) % Jjump condition

v = 1; % report jump
else
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33

o)

v = 0; % do not report jump
end

A solution to the system of a vehicle following a track in {(£1,&) : —1 <& < 1}, and with T = 15, J = 10,
rule = 1, is depicted in Figure (trajectory). Both the projection onto ¢t and j are shown. Figure
depicts the corresponding hybrid arc.

For MATLAB/Simulink files of this example, see Examples/Example_1.5.

Example 5.4 (interconnection of hybrid systems #; (bouncing ball) and H, (moving platform)) Consider
a bouncing ball (1) bouncing on a platform (#s) at some initial height and converging to the ground at
zero height. This is an interconnection problem because the current states of each system affect the behavior
of the other system. In this interconnection, the bouncing ball will contact the platform, bounce back up,
and cause a jump in height of the platform so that it gets closer to the ground. After some time, both the
ball and the platform will converge to the ground. In order to model this system, the output of the bouncing
ball becomes the input of the moving platform, and vice versa. For the simulation of the described system
with regular data where H; is given by

fi(&ur,v) = { o b£§22 +on ;Cr={(§u) | & > u,un >0} (20)
a 2
g1(& ur,vr) = { e§1|§j| +1§?2 } Di={(w) | & =u,ur >0}, y1 =hi(§) =& (21)

where v, b, a1 > 0,e; € [0,1), € = [£1,&] T is the state, y; € R is the output, u; € R and vy = [v11,v12] | € R?
are the inputs, and the hybrid system Hs is given by

2
, U, Vo) 1= ,Cy = , U <ug,m >0 22
A= %G () ImSwmz0) (@)
-«
g2(n, uz,v2) = [ —77612|772|2-||'?712le ] Do i={(n,uz) | m =uz,m >0}, 92 = hao(n) :=m (23)
T

where ay > 0,e5 € [0,1), n = [n1,m2]" € R? is the state, y2 € R is the output, and uy € R and vy =
[va1,v92] T € R? are the inputs.

Therefore, the interconnection may be defined by the input assignment
Uy = Y2, U2 = Y1. (24)

The signals v; and vy are included as external inputs in the model in order to simulate the effects of
environmental perturbations, such as a wind gust, on the system.

The MATLAB scripts in each of the function blocks of the implementation above are given as follows.
The constants for the interconnected system are v = 0.8, b = 0.1, and a1, as = 0.1.

e For hybrid system H;:

Flow map

function xdot = f(x, u)

5555555555555 5555555555555 5555555555555 5555555555555 55%5%5%5%5%5%%
Matlab Function Author: Ricardo Sanfelice

Project: Simulation of a hybrid system (interconnection)

® N O G e W N e

o° o© o° o° o

Name: f.m
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This model simulates the interconnection
of two hybrid systems; a bouncing ball and a moving platform.

Double Click Double Click to
to Initialize Plot Solutions

More Info I

oA
v11
HS 1
v12
x3 HS 2
state1

Figure 15: MATLAB/Simulink implementation of interconnected hybrid systems ;1 and Hs

%input

y2 = u(l);
vll = u(2);
v1i2 = u(3);

% flow map

gxdot=f (x,u);

xildot = xi2;

xi2dot = -0.8-0.1%*xi2+v11;

xdot = [xildot;xi2dot];

39
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flows [i]
1 T T T T T T T T
_1 1 1 1 1 1 1 1 1
0 2 4 6 8 10 12 14 16 18
flows [t]

Flow set

function v = C(x, u)

5555555555555 5555555555555 5555555555555 55555555555555555%%5%5%5%%
Matlab Function Author: Ricardo Sanfelice

o\

Project: Simulation of a hybrid system

o® o o oP

Name: C.m

o° o

Description: Flow set

Version: 1.0
Required files: -

o0 oo o°

5555555555555 55555555 5%5%5%5%5%5%5%55%5555555555555%5%5%5%5%5%5%5%5%55555555555%%5%5%5%5%5%5%5%%%

% state

xil = x(1);

x12 = x(2);

$input

y2 = u(l);

vlil = u(2);

v1i2 = u(3);

if (xil >= y2) % flow condition

40
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Figure 17: Solution of Example for system H;

26 v = 1; % report flow
27 else
28 v = 0; % do not report flow
29 end
Jump map
1 function xplus = g(x, u)
2
3 T s T LTI 5%5%%
4 % Matlab Function Author: Ricardo Sanfelice
5 %
6 % Project: Simulation of a hybrid system (interconnection)
7T %
8 % Name: g.m
9 3
10 % Description: Jump map
1 %
12 % Version: 1.0
13 % Required files: -

14 33355 5555555%5%55555555555555%5%5%5%5%5%5%555555555555%5%5%5%5%5%5%5%5%5%5%555555555%5%5%5%5%5%5%5%5%%%

16 % state
17 xil = x(1);

18 x12 = x(2);
19

20 Sinput

21 y2 = u(

1);

22 v1l = u(2);
23 v12 = u(3)

24

25 xilplus=y2+0.1%*x1i272;

26 x1i2plus=0.8xabs(xi2)+v12;
27

4
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Figure 18: Solution of Example for system Ho

28 xplus = [xilplus;xi2plus];
Jump set
1 function v = D(x, u)
2
3 555N 5555%5%
4 % Matlab Function Author: Ricardo Sanfelice
5 %
6 % Project: Simulation of a hybrid system (interconnection)
7T %
8 % Name: D.m
9 %
10 % Description: Jump set
1 %
12 % Version: 1.0
13 % Required files: -
14 5555555505555 5555555555555 555555555555 5555%5%5%5%%%
15
16 % state
17 xil = x(1);
18 xi2 = x(2);
19
20 %input
21 y2 = u(l);
22 v1l = u(2);
23 v12 = u(3);
24
25
26 1if (xil1l <= y2) % Jump condition
27 v = 1; % report jump
28 else
29 v = 0; % do not report Jjump
30 end
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e For hybrid system Hs:
Flow map

function xdot = f(x, u)

5555555555555 5555555555555 5555555555555555555555%555555%55%5%%5%5%5%%
Matlab Function Author: Ricardo Sanfelice

o

Project: Simulation of a hybrid system (interconnection)

o oo o°

o\

Name: f.m

o

Description: Flow map

o oo o°

Version: 1.0
Required files: -
5555555555555 5555555555555 555555555555 5%5555%5%555%%5%5555%5%555%5%5%5%5%%5%5%5%5%%%

o

[

% state
etal = x(1);
eta2 ;

I
%
S
<

$input
vyl = u(l);
v21l = u(2);
v22 = u(3)

4

Q

% flow map
etaldot = eta2;
etaZ2dot = —-etal-2*etal2+v2l;

xdot = [etaldot;eta2dot];

Flow set

function v = C(x, u)

5555555555555 5555555555555 5555555555555 5555555555555555555555%5%%%
Matlab Function Author: Ricardo Sanfelice

o\

o

Project: Simulation of a hybrid system (interconnection)

o oo o°

Name: C.m

o

o

Description: Flow set

o\°

Version: 1.0
Required files: -
5555555555555 5555555555555 555555555555 5555555555555555%555%%5%5%5%%

o° o

Q

% state
etal = x(1);

43



18
19
20
21
22
23
24
25
26
27
28
29

© 00 N O U R W N

NN NN N NDNNDNDDNRE B B 2 = = =R
© 00 N O Uk W N O O 0N OO e W N = O

0 N O Utk W N =

Jump map

yl) % flow condition

Q

% report flow

Q

% do not report flow

function xplus = g(x, u)

5555555555555 5555555 555%5%5%5%5%5%5555 55555555 5555%5%5%5%5%55%55555555555%5%5%5%5%5%5%5%5%%%

o o0 A0 O o O O° o° o o

555555555555 5555555 5555%5%5%5%5%5%555 555555 555555%5%5%5%5%5%5%5%55555555555%5%5%5%5%5%5%5%5%%%

[

$input

yl = u(
v21l = u
v22 = u

o

°

etalplus
eta2plus

Xp

Matlab Function Author: Ricardo Sanfelice

Project:

Name :

g.

m

Simulation of a hybrid system (interconnection)

Description: Jump map

Version:

1.0

Required files: -

state

Jjump map
= yl1-0.1lxabs (eta2);

lus =

Jump set

-0.8xabs (eta2) +v22;

[etalplus;eta2plus];

function v

5555555555555 5555555555555 555555555 5%5%5%5%5%5%5%5%55%555555555%%%5%5%5%5%%5%%%

o0 o0 o° o° oP

= D(x, u)

Matlab Function Author: Ricardo Sanfelice

Project:

Name :

D.

m

Simulation of a hybrid system
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o
Cl
o . . X
10 % Description: Jump set
o
11 c)
o) . °
12 % Version: 1.0
13 % Required files: -
000000000000000000000000000000000000000000000000000000000000000000000000000
14 3355555555555 55%5%555%555%5555%555%555%5%55%5%5%5%5%55%5%555%5%555%555%555%5%53%5%5%5%5%53%5%5%3%5%5%%5%%
15

16 % state
17 etal = x(1);

18 eta2 = x(2);

19

20 %input

21yl = u(l);

22 v21 = u(2);

23 v22 = u(3);

24

25

26 1f (etal >= yl) % Jump condition
27 v = 1; % report jump

28 else

29 v = 0; % do not report jump
30 end

A solution to the interconnection of hybrid systems H; and He with T' = 18, J = 20, rule = 1, is depicted
in Figure Both the projection onto ¢ and j are shown. A solution to the hybrid system #; is depicted
in Figure [17(a)| (height) and Figure [17(b)| (velocity). A solution to the hybrid system Hy is depicted in
Figure (height) and Figure [L8(b)| (velocity).

These simulations reflect the expected behavior of the interconnected hybrid systems.

For MATLAB/Simulink files of this example, see Examples/Example_1.6.

[u]

Example 5.5 (biological example: synchronization of two fireflies) Consider a biological example of the
synchronization of two fireflies flashing. The fireflies can be modeled mathematically as periodic oscillators
which tend to synchronize their flashing until they are flashing in phase with each other. A state value of
7; = 1 corresponds to a flash, and after each flash, the firefly automatically resets its internal timer (periodic
cycle) to 7; = 0. The synchronization of the fireflies can be modeled as an interconnection of two hybrid
systems because every time one firefly flashes, the other firefly notices and jumps ahead in its internal timer
7 by (1 + &)7, where ¢ is a biologically determined coefficient. This happens until eventually both fireflies
synchronize their internal timers and are flashing simultaneously. Each firefly can be modeled as a hybrid
system given by

fl‘(Ti,ui) = 1, (25)
Ci = {(Ti7ui)€R2 |0§TZ§1}0{(TZ,’LLZ)GR2 |0§U2§1} (26)
o) = {07 B2 m
D, = {(Ti7ui)€R2 |Ti:1}U{(Ti,ui)€R2 |u1:1} (28)

The interconnection diagram for this example is simpler than in the previous example because now no
external inputs are being considered. The only event that affects the flashing of a firefly is the flashing of
the other firefly. The interconnection diagram can be seen in Figure

For hybrid system H,;, ¢ = 1,2:

Flow map
function taudot = f (tau, u)
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This model simulates interconnected hybrid systems.

Double Click X J|:

state

to Initialize

j ime
Double Click to X'(in‘)ﬂz

Plot Solutions Hybrid System 1 jumps

ﬁ
j t|me1

Hybrid System 2 jumps1

Figure 19: Interconnection Diagram for Example

Matlab Function Author: Ricardo Sanfeli
Project: Simulation of a hybrid system (interconnection)
Name: f.m

Description: Flow map

Version: 1.0

Required files: -
5555555555555 5555555555555 5555555555 5555555555555 55%5%5%55%%5%5%5%%5%5%5%%

o\°

flow map
audot = 1;

Flow set
unction v = C(tau, u)

5555555555555 5555555555555 5555555555555555555555%555%555%5%55%5%5%5%%
Matlab Function Author: Ricardo Sanfelice

Project: Simulation of a hybrid system (interconnection)
Name: C.m

Description: Flow set

Version: 1.0

Required files: -
5555555555555 5555555555555 5555555555555 5535555555%%5%5%%

$flow set
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(a) Solution for system #;

(b) Solution for system H2

Figure 20: Solution of Example [5.5

if ((tau > 0) && (tau < 1)) || ((u > 0) && (u <=
v =1; % report flow
else
v = 0; % do not report flow
end
Jump map
function tauplus = g(tau, u, e)

Matlab Function Author: Ricardo Sanfelice

Project: Simulation of a hybrid system
Name: g.m
Description:

Jump map

Version: 1.0
Required files: -

00 0 0 O O O O° o° A O o° oP

o\°

jump map

if (l+e)*tau < 1
tauplus = (l+e) xtau;
elseif (l+e)x+tau >= 1
tauplus = 0;
else
tauplus = tau;
end
Jump set
function v = D(tau, u)
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1)) % flow condition
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© 00 N O O W

10
11
12
13
14
15
16
17
18
19
20

-
w

S 1 T
£ | | | |
5 | | | |
AR AR
| | | |
0 1 1
0 6 8 12
flows [i]
1.5 T T T T T T T T T T T T T T
Y * . - *
5 N R S A R A SN S A A S S
- I T R S A e R N N
5 + - S S N KA T T E N B
£ 0.5¢ ' e A A R H R R R N B
¥ N + I T T R B
I N T Lol
0 1 1 1 1 1 1 Sk 1 1 1 1 1
o 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
jumps [j]

Figure 21: Solution of Example [5.5] for interconnection of H; and Hs

5555555555555 5555555555555 5555555555555 5555555555555555555555555%5%%%
Matlab Function Author: Ricardo Sanfelice

o o

Project: Simulation of a hybrid system (interconnection)

o o oo

Name: D.m

o° o

Description: Jump set

Version: 1.0

o o oo

Required files: -
5555555555555 55555555555 5555555555555 5555555555555 55%5%5555%5%5%55%5%5%5%5%5%%

if (u >= 1) || (tau >= 1) % Jjump condition
v = 1; % report jump

<
I

0; % do not report jump
end

A solution to the interconnection of hybrid systems H; and Hs with 7' = 15,J = 15, rule = 1, ¢ = 0.3
is depicted in Figure Both the projection onto ¢ and j are shown. A solution to the hybrid system #;
is depicted in Figure A solution to the hybrid system #H, is depicted in Figure [20(b)

These simulations reflect the expected behavior of the interconnected hybrid systems. The fireflies initially
flash out of phase with one another and then synchronize to flash in the same phase.

For MATLAB/Simulink files of this example, see Examples/Example_1.7.
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Example 5.6 (a simple mathematical example to show different type of simulation results) Consider the
hybrid system with data

f(z) = -z, C:=10,1], g(z) := 1+ mod(x,2), D:= {1} U{2}.

Note that solutions from £ = 1 and ¢ = 2 are nonunique. The following simulations show the use of the
variable rule in the Jump Logic block.

Jumps enforced: A solution from 20 = 1 with 7' = 10, J = 20, rule = 1 is depicted in Figure
The solution jumps from 1 to 2, and from 2 to 1 repetitively.

Flows enforced: A solution from x0 = 1 with T' = 10,J = 20, rule = 2 is depicted in Figure [22(b)|
The solution flows for all time and converges exponentially to zero.

181
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12 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 [

jumps [j] P

(a) Forced jumps logic. (b) Forced flows logic.

Figure 22: Solution of Example [5.6

Random rule: A solution from z0 = 1 with 7' = 10, J = 20, rule = 3 is depicted in Figure [23(a)l The
solution jumps to 2, then jumps to 1 and flows for the rest of the time converging to zero exponentially.
Enlarging D to

D :=[1/50,1] U {2}

causes the overlap between C' and D to be “thicker”. The simulation result is depicted in Figure with
the same parameters used in the simulation in Figure The plot suggests that the solution jumps several
times until < 1/50 from where it flows to zero. However, Figure a zoomed version of Figure
shows that initially the solution flows and that at (¢, j) = (0.2e — 3,0) it jumps. After the jump, it continues
flowing, then it jumps a few times, then it flows, etc. The combination of flowing and jumping occurs while
the solution is in the intersection of C' and D, where the selection of whether flowing or jumping is done
randomly due to using rule = 3.

This simulation also reveals that this implementation does not precisely generate hybrid arcs. The
maximum step size was set to 0.1e — 3. The solution flows during the first two steps of the integration of
the flows with maximum step size. The value at ¢t = 0.1e — 3 is very close to 1. At ¢ = 0.2e — 3, instead of
assuming a value given by the flow map, the value of the solution is about 0.5, which is the result of the jump
occurring at (0.2e — 3,0). This is the value stored in x at such time by the integrator. Note that the value
of 2’ at (0.2e — 3,0) is the one given by the flow map that triggers the jump, and if available for recording,
it should be stored in (0.2¢ — 3,0). This is a limitation of the current implementation.

The following simulations show the Stop Logic block stopping the simulation at different events.

Solution outside C'U D: Taking D = {1}, a simulation starting from z0 = 1 with 7" = 10, J = 20,
rule = 1 stops since the solution leaves C' U D. Figure [24(a)| shows this.
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sion.

Figure 23: Solution of Example [5.6

Solution reaches the boundary of C from where jumps are not possible: Replacing the flow
set by [1/2,1] a solution starting from x0 = 1 with 7' = 10, J = 20 and rule = 2 flows for all time until it
reaches the boundary of C' where jumps are not possible. Figure [24(b)|shows this.

Note that in this implementation, the Stop Logic is such that when the state of the hybrid system is not
in (C'U D), then the simulation is stopped. In particular, if this condition becomes true while flowing, then
the last value of the computed solution will not belong to C. It could be desired to be able to recompute
the solution so that its last point belongs to the corresponding set. From that point, it should be the case
that solutions cannot be continued.

For MATLAB/Simulink files of this example, see Examples/Example_1.8.

Example 5.7 (Linear time-invariant plant)
Following the model of a physical component in , a linear time-invariant model of the physical
component is defined by

f(z,u) = fp(x,u) = Apx + Bpu, h(z,u) = h(x,u) = Mpx + Npu
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Figure 24: Solution of Example with premature stopping.

where Ap, Bp, Mp, and Np are matrices of appropriate dimensions. State and input constraints can directly
be embedded into the set C'p. For example, the constraint that = has all of its components nonnegative and
that » has its components with norm less or equal than one is captured by

Cp = {(z,u) eR™ xR™ |z; >0Vie{l,2,...,np}}
N{(z,u) e R" xR™? | |u;| <1Vie{1,2,...,mp}}

For example, the evolution of the temperature of a room with a heater can be modeled by a linear-time
invariant system with state x denoting the temperature of the room and with input « = (uy, us), where u;
denotes whether the heater is turned on (u; = 1) or turned off (u; = 0) while us denotes the temperature
outside the room. The evolution of the temperature is given by

i = —x+[z2a 1] [Z;] when (z,u) € Cp = {(z,u) e R xR* | u; € {0,1} } (29)

where za is a constant representing the heater capacity. [u]

Example 5.8 (Implementation of a FSM)

Transitions of the state of a FSM are triggered by changes of its input v. The system can be modeled as
a cascade of two systems, in which an external signal drives the FSM. The FSM is modeled as the difference
equation in . Assuming that the input feeds the input u of the FSM, the state of the FSM is updated
according to the transition function evaluated at the current input, that is, g is updated according to

+:

q (q,u)

The above model can be summarized as follows:

g = o] (30)

€= {(gu) € {1,2) x {12} x (1,2} x {1,2} | d(g,) = g} (31)
slan) = o) = |3 ). (32)
D= {(q.u) € (1.2}  {L.2) x {1,2) x {1.2} | o(g.u) € {1.2) x {1,2} \a} (33)

y:=h(g) =q (34)
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Figure 25: Simulation of a Finite State Machine (FSM) in Example [5.§

where the input and the state are given by u = (ug, u2) € {1,2} x {1,2}, and ¢ = (¢1,q2) € {1,2} x {1,2},
respectively.
For the hybrid system FSM in Figure [25] we have the following Matlab embedded functions that describe
the sets C' and D and functions f and g. Figure [26] depicts the corresponding inputs and state of the FSM.
Flow map
function xdot = f(x, u)
Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

o° o o oP

% Project: Simulation of a hybrid system Finite state machine (FSM)
% Description: Flow map

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

o® o° o° o o

o° o

flow map: xdot=f (x,u);

n = length (x) % size of the g state

7
gqdot = zeros(n,l); % dynamics of the g state
xdot = [gdot];
Flow set
function v = C(x, u)

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

o° o o oP

% Project: Simulation of a hybrid system Finite state machine (FSM)
% Description: Flow set
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See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Check on flow conditions

o0 o0 o0 0 O O o° O° O° A° d° o o°

E.g.,
if (x(l) >= u(l)) % flow condition
v = 1; % report flow
else
v = 0; % do not report flow
end
xtemp = zeros(2,1);
xtemp = Xx;

X = Xtemp;

% n = length(x); % size of the g state
gplus = zeros(2,1); % dynamics of the g state
% e.g.,
gplus (1) 3-u(l);
gplus(2) = 3-u(2);
if x(1)==gplus(l) && x(2)==gplus(2)
v = 1; % report flow
else
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v = 0; % do not report flow

Jump map
unction xplus = g(x, u)

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system Finite state machine (FSM)
Description: Jump map

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Jjump map: xplus = g(x,u);

n = length (x); size of the g state

gplus = zeros(2,1); % dynamics of the g state

e.g.,

gplus (1) = 3-u(l);

aplus (2)

I
w
c
S
g

xplus = [gplus];

£

o° o° o o

oe

o0 o0 o° o° o o° O° A A° A° o° o o

Jump set
unction v = D(x, u)

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system Finite state machine (FSM)
Description: Jump set

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Check on jump conditions

Q

s E.g.,

1f (x(1) <= u(l)) && (x(2) <= 0) % Jjump condition
v = 1; % report jump

else
v = 0; % do not report Jjump

end
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Figure 27: Estimation over a network scheme in Example 5.9

xtemp = zeros(2,1);
xtemp = X;
X = Xtemp;
% n = length(x); % size of the g state
gplus = zeros(2,1); % dynamics of the g state
% e.g.,
gplus (1) = 3-u(l);
gplus(2) = 3-u(2);
if x(1)==gplus(l) && x(2)==gplus(2)

v = 0; % do not report jump
else

v = 1; % report Jjump
end

o

Example 5.9 (Estimation Over a Network) Consider a physical process given in terms of the state-space

model
i = Ax, y= Mz, r €R" yeR™ (35)

where x is the state and y is the measured output. The output is digitally transmitted through a network.
At the other end of the network, a computer receives the information and runs an algorithm that takes the
measurements of y to estimate the state = of the physical process. In Figure 27] the scheme of the simulation
is presented. We consider an estimation algorithm with a state variable £ € R™?, which denotes the estimate
of x, that is appropriately reset to a new value involving the information received. More precisely, denoting
the transmission times by ¢; and L a constant matrix to be designed, the estimation algorithm updates its
state as follows

it =2+ Ly — M2) (36)

at every instant information is received. In between such events, the algorithm updates its state continuously
so as to match the evolution of the state of the physical process, that is, via

&= A# (37)

Modeling the network as a hybrid system, which, in particular, assumes zero transmission delay, the state
variables of the entire system are jy, 7v € R, my € R™”, and x, & € R"?. Then, transmissions occur when
7n < 0, at which events the state of the network is updated via

7—IJ\? € [T;]min’T;[max]’ jJJ\rf = jN + 1a m?\} =Y
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and the state of the algorithm is updated via . Note that since the state of the physical process does
not change at such events, we can use the following trivial difference equation to update it at the network
events:

l’+:$

In between events, the state of the network is updated as
iv=-1 Jy, 1y =0

the state of the algorithm changes continuously according to , and the state of the physical process
changes according to . Considering the equations above, we arbitrarily pick the following data for each
of the subsystems in Figure

e Physical process:

fp(z,u) = Ax + Bu, Cp :=R" xR (38)
Gp(z,u) ==z, Dp:=0, y=h(z) := Mz (39)
where
0 1 0 0 0
-1 0 0 0 0
A=1_5 1 1 o] B=|o| M=[ 000, (40)
2 -2 0 =2 0

np=4r1r7,=12z€R"” ycR7? anducR.

o Network:
[0
flen,un):=| 0 |, C:={(zn,un) | T 20}, (41)
—1
S
g(zn,un) = |Jjnv + 1], D :={(zn,un) | T <0}, yn=h(zy) =2an (42)
Tr

where 7, € [Tx™",T%™*] is a random variable that models the time in-between communication
instances. Also, the sate and the input are given by xy = (my,jn,7n) € RxRxR, and uy =y € R"»,
respectively.

e Estimator:

flapug) = oo+ || o C={wsup) lje=in}.  (43)
ol(2.e).ug) = |7 T M), D= (@) [jseN\in}, (40
where L, which is designed as in [6], is given by
1
| w
1.6274

the input and the state are given by ugp = (xn,v) = ((my,JN,7N),v) E RXR X R X R, and g =
(#,78) € R* xR, respectively. Notice that the estimator block (Estimator) in Figureis implemented
using a regular hybrid system block with embedded functions.
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Figure 28: Estimated states Vs. continuous plant states

For each hybrid system in Figure 27| (HSu, network, and Estimator) we have the following Matlab em-
bedded functions that describe the sets C' and D and functions f and g. Figure 2§ depicts the corresponding
hybrid arc for the position state.

e Continuous process:

Flow map

function zdot = f(z, u, ctes)

% Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
% https://hybrid.soe.ucsc.edu/software

% http://hybridsimulator.wordpress.com/

% Project: Simulation of a hybrid system (plant with constraints in the
% state and the input)

% Description: Flow map
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See also HYEQSOLVER, PLOTARC, PLOTARC
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTH
Copyright @ Hybrid Systems Laboratory
Revision: 0.0.0.3 Date: 05/20/2015 3:

o° o0 o o° oP

flow map: xdot=f (x,u);
ctes = [A,B,M',L,P];

o0 o o

= ctes(:,1:4);
= ctes(:,5);

= ctes(:,0)’;
= ctes(:,7);

e oo
=

e
|

zdot = Axz + Bxu;

Flow set

function v =

Matlab M-file Project: HyEQ Toolbox @
https://hybrid.soce.ucsc.edu/software
http://hybridsimulator.wordpress.com/

o° o o o°

% Project: Simulation of a hybrid system
% Description: Flow set

o\

See also HYEQSOLVER, PLOTARC, PLOTARC
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTH
Copyright @ Hybrid Systems Laboratory
Revision: 0.0.0.3 Date: 05/20/2015 3:

Check on flow conditions

o 00 O o A A O o O o° o° o° oP°

E.g.,
if (x(1) >= u(l)) % flow condition
v =1; % report flow
else
v = 0; % do not report flow
end
v = 1; % report flow
Jump map

function xplus =

Matlab M—-file Project: HyEQ Toolbox @
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

o° o o o°

o° o

Project: Simulation of a hybrid system

o8

3, PLOTFLOWS, PLOTHARC,

YBRIDARC, PLOTJUMPS.
(HSL),

42:00

Hybrid Systems Laboratory

3, PLOTFLOWS, PLOTHARC,

YBRIDARC, PLOTJUMPS.
(HSL) ,

42:00
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% Description: Jump map

o\

See also HYEQSOLVER, PLOTARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D,

o° o0 o° o° oP

Copyright @ Hybrid Systems Laboratory

PLOTFLOWS, PLOTHARC,
PLOTHYBRIDARC, PLOTJUMPS.
(HSL) ,

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

% Jump map: xplus = g(x,u);
xplus = zeros(4,1);
xplus = x;
Jump set
function v = D(x, u)
% Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
% https://hybrid.soe.ucsc.edu/software
% http://hybridsimulator.wordpress.com/
% Project: Simulation of a hybrid system
% Description: Jump set
% See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
% PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
% Copyright @ Hybrid Systems Laboratory (HSL),
% Revision: 0.0.0.3 Date: 05/20/2015 3:42:00
% Check on Jjump conditions
% % E.g.,
$ 1if (x(1) <= u(l)) && (x(2) <= 0) % jump condition
% v =1; % report jump
% else
% v = 0; % do not report jump
% end
v = 0; % do not report jump
Network:
Flow map
function xdot = f(x,vs)

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),

o0 o o oe

https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

PLOTARC3,

% Project: Simulation of a hybrid system Digital network (net)
% Description: Flow map
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See also HYEQSOLVER, PLOTARC,
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[

PLOTARC3,
PLOTHARCCOLOR, PLOTHARCCOLOR3D,
Copyright @ Hybrid Systems Laboratory (HSL),
Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

PLOTHYBRIDARC,

n = length(vs); % measured input size

msdot = zeros(n,l); % measured continuous dynamics

jdot = 0;
tau_sdot = -1; % Timer tau_s
xdot = [msdot; jdot;tau_sdot];

Flow set

function v = C(x, vs, Tnmax)

o0 o o oe

o o° oP

Description: Flow set

o°

See also HYEQSOLVER, PLOTARC,

Check on flow conditions
E.g.,

0 A o o 0 O o A O o o° o° o

PLOTARC3,
PLOTHARCCOLOR, PLOTHARCCOLOR3D,
Copyright @ Hybrid Systems Laboratory (HSL),
Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

PLOTHYBRIDARC,

if (x(1) >= u(l)) % flow condition
v = 1; % report flow
else
v = 0; % do not report flow
end
tau_s = x(end); % timer state

if tau_s>=0 && tau_s<= Tnmax
v =1; % report flow
elseif tau_s> Tnmax
v = 0; % do not report flow
else
v = 0;
end

Jump map

PLOTJUMPS.

Project: Simulation of a hybrid system Digital network (net)

PLOTJUMPS.

PLOTFLOWS, PLOTHARC,

Matlab M-file Project: HyEQ Toolbox @
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

PLOTFLOWS, PLOTHARC,

=W N =

function xplus = g(x, vs, Tnmax, Tnmin, tk)

% Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
% https://hybrid.soe.ucsc.edu/software
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http://hybridsimulator.wordpress.com/
Project: Simulation of a hybrid system Analog-to-Digital converter (ADC)
Description: Jump map

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

[

n = length(vs); % measured input size
xtemp = zeros (n+2,1);

xtemp = X;

X = xXtemp;

J = x(n+l);

msplus = vs; % output = measured input

[
i)

t

The value tau_s 1s updated as a function of vs, e.g.,

Q

au_splus = tk(j+1l); % Timer tau_s

j_plus = J+1;
xplus = [msplus; j_plus;tau_splus];

Jump set

function v = D(x, vVvs)

o° 0P o o

o 0P o°

o\°

o 00 o O A A O O A A° o° o° oP

t

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system Analog-to-Digital converter (ADC)
Description: Jump set

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Check on jump conditions

$ E.g.,
if (x(1) <= u(l)) && (x(2) <= 0) % Jump condition
v = 1; % report jump
else
v = 0; % do not report jump
end
au_s = x(end); % timer state
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if tau_s>=0
v = 0; % do not report Jjump
elseif tau_s<= 0

v = 1; % report jump
else
v = 0;
end
Estimator:
Flow map
function xdot = f(x, v,ctes)

https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

o0 o0 o oe

Project: Simulation of a hybrid system

o° oo o

Description: Flow map

oe

PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),
Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

o° o0 o° o° oP

flow map: xdot=f (x,u);

o° o o

ctes = [A,B,M",L,P];
A = ctes(:,1:4);
B = ctes(:,5);
$ M = ctes(:,0)";
$ L = ctes(:,7);
n = length(A);
u = v(end);
z = x(1l:n);
jdot = 0;

zdot = Axz + Bxu;
xdot = [zdot; jdot];

Flow set

function out = C(x, V)

% Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory
% https://hybrid.soe.ucsc.edu/software

% http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system
Description: Flow set

o° o° oo o°

o° o

62

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
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PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),
Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Check on flow conditions

E.g.,
if (x(1) >= u(l)) % flow condition
v =1; % report flow
else
v = 0; % do not report flow
end

= x(end); % internal communication memory event

jnet = v(end-2); % communication event
if j == Jjnet
out = 1; % report flow
else
out = 0;
end
Jump map
function xplus = g(x, v, ctes)

o° o° o o

o° o° o°

oe

o0 o0 o° o° oP

o° o

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system

Description: Jump map

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Jjump map: xplus = g(x,u);
A = ctes(:,1:4);
M = ctes(:,06)';
L = ctes(:,7);
n = 4;
z = zeros(4,1);
zplus = zeros(4,1);
xplus = zeros(5,1);
z = x(1:4);
jnet = v(2); % communication event
y = vi(l);

Jjplus = Jjnet;
zplus = z + Lx(y—-Mxz);
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32 xplus = [zplus; jplus];

Jump set
1 function out = D(x, V)
2 T
3 % Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
4 % https://hybrid.soe.ucsc.edu/software
5 % http://hybridsimulator.wordpress.com/
B T T T T
7 % Project: Simulation of a hybrid system
8 % Description: Jump set
O T T
10 BT
1 % See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
12 % PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
13 % Copyright @ Hybrid Systems Laboratory (HSL),
14 % Revision: 0.0.0.3 Date: 05/20/2015 3:42:00
15 %
16 % Check on jump conditions
7 % % E.g.,
18 % 1f (x(1) <= u(l)) && (x(2) <= 0) % Jjump condition
19 % v = 1; % report jump
20 % else
21 % v = 0; % do not report jump
22 % end
23
24
25 n = length(x)-1; % measured input size
26 J = x(end); % internal communication memory event
27 jnet = v(end-2); % communication event
28
29 1if j "= jnet
30 out = 1; % report Jjump
31 else
32 out = 0;
33 end
34

[m}

Example 5.10 (Sample-and-hold Feedback Control) Consider a physical process modeled as in Exam-
ple and a state feedback interconnection. The algorithm (static gain) uses measurements of its output
and controls the input of the physical process with the goal of steering its state to zero. Suppose the sampling
device is ideal and that the signals are connected to the plant via a DAC modeled as in —.

The interconnection between the models of the physical process, the sampling device, the finite state
machine, and the DAC has the feedback topology shown in Figure In particular, the output of the DAC
is connected to the input u of the physical process by a matrix gain K, while the input v of the finite state
machine is equal to the output y of the physical process at every sampling instant.

e Physical process:

fp(z,u) := Az + Bu, Cp :=R? x R? (46)
Gp(z,u) =z, Dp:=0, y="h(z) == (47)

64



0 1
0 —b/m

e Analog-to-Digital Converter (ADC):

where A = { },B: [1 1/m], and z = (z1,22) € R?.

0
f(xau) = (1) , Ci= {(lvu) ‘ Ts € [OaTs*]}v (48)
o= o] Dim (@) |72 T}, y=hio) = (19)

where x = (mg, 75) € R x R?, and u € R?,

e Zero-Order Hold (ZOH):
0
flz,u) = ? , C:={(z,u) | 7, €0, T2}, (50)
g(z,u) == [8} s, Di={(z,u) | 7s >TF}, y=h(z):=z (51)

where z = (mg, 75) € R x R?, and u € R?.

The feedback gain is given by K = {kl} .

ko
Double Click Double Click to
1o Initialize Plat Sciutions:

> y
L ! i x
t
ZHO > I:secl U
o x-(int) »| C° uvec
- HSu
Swiich o -
ici
J o anc - Ko
ADCE
W w =TT
|—’ ju
T E — 3
__* ZOH » jzs
— z01L }
3 > tzs
[Tt > — — > Z8
v”'; 0 "
Salactor

Figure 29: Sample and hold feedback interconnection for Example [5.10

For each hybrid system in Figure (HSu, ADC, and ZOH) we have the following Matlab embedded
functions that describe the sets C' and D and functions f and g. Figure [30| presents a numerical simulation
of the interconnected system.

65



© 00 N O Utk W N =

NN NN R R R R R R R e e
W N =2 O ©W 0N O Uk W N = O

states - measured states

control signal

201 ]

o5 I I I I I I I I I
0 0.5 1 1.5 2 25 3 3.5 4 4.5 5

time

Figure 30: Measuread states and inputs.

e Continuous process:

Flow map

function xdot = f(x, u, ctes)

o° o° o o

o° 0P o o°

oe

o° o0 o o° oP

o° o

o\

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system (plant with constraints in the
state and the input)
Description: Flow map

See also PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC, PLOTHARCCOLOR,
PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.

Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

flow map: xdot=f (x,u);
ctes = [A,B,C,K'];
ctes(:,1:2);

ctes(:,3);
ctes(:,4:5);
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K = ctes(:,6)’;

xdot = Axx + B=*u;

Flow set

function v = C(x, u)

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

o0 o o oe

Project: Simulation of a hybrid system
Description: Flow set

o° oo o

o\

See also PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC, PLOTHARCCOLOR,
PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.

Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Check on flow conditions
E.g.,
if (x(1) >= u(l)) % flow condition
v = 1; % report flow
else
v = 0; % do not report flow
end

o o0 A0 O o O O O o O o° o° oP

[

v = 1; % report flow

Jump map

function xplus = g(x, u)

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

o0 o o oe

Project: Simulation of a hybrid system
Description: Jump map

o° oo o

o\

% See also PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC, PLOTHARCCOLOR,
% PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.

% Copyright @ Hybrid Systems Laboratory (HSL),

% Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

% Jump map: xplus = g(x,u);

xplus = x;
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Jump set

function v. = D(x, u)

o° o o o°

o0 o o

oe

o 0 O o A A O o O O° o° o oP°

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system

Description: Jump set

See also PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC, PLOTHARCCOLOR,
PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.

Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Check on jump conditions

% E.g.,

if (x(1) <= u(l)) && (x(2) <= 0) % Jump condition
v =1; % report jump

else
v = 0; % do not report jump

end

v = false; % do not report jump
ADC and ZOH:

Flow map

function xdot = f(x,vs)

o0 o o oe

o° oo o°

o

o° o0 o° o° oP

n

m
t
X

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system Analog-to-Digital converter (ADC)
Description: Flow map

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Q

= length(vs); % measured input size

sdot = zeros(n,l); % measured continuous dynamics
au_sdot = 1; % Timer tau_s
dot = [msdot;tau_sdot];

Flow set
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function v = C(x, vs, Ts)

o® 0P o o

o oo o°

o\

o o0 O O A A O o A A° o° o° oP°

ol

t

i

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system Analog-to-Digital converter (ADC)
Description: Flow set

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

Check on flow conditions

E.g.,
if (x(l) >= u(l)) % flow condition
v =1; % report flow
else
v = 0; % do not report flow
end

[

= length(vs); % measured input size
au_s = x(end); % timer state
f tau_s>=0 && tau_s<= Ts

v =1; % report flow

elseif tau_s> Ts
v = 0; % do not report flow
else
v = 0;
end
Jump map
function xplus = g(x, vs)

o0 o o oe

o° o° oP

o

o° o0 o° o° oP

o]

Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
https://hybrid.soe.ucsc.edu/software
http://hybridsimulator.wordpress.com/

Project: Simulation of a hybrid system Analog-to-Digital converter (ADC)
Description: Jump map

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.
Copyright @ Hybrid Systems Laboratory (HSL),

Revision: 0.0.0.3 Date: 05/20/2015 3:42:00

[)

= length(vs) % measured input size
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18
19 msplus = vs; % output = measured input

20 tau_splus = 0; % Timer tau_s
21 xplus = [msplus;tau_splus];
22
23
24
Jump set
1 function v = D(x, vs, Ts)
2
3 % Matlab M-file Project: HyEQ Toolbox @ Hybrid Systems Laboratory (HSL),
4 % https://hybrid.soe.ucsc.edu/software
5 % http://hybridsimulator.wordpress.com/
6 ST T T
7 % Project: Simulation of a hybrid system Analog-to-Digital converter (ADC)
8 % Description: Jump set
9 BT

See also HYEQSOLVER, PLOTARC, PLOTARC3, PLOTFLOWS, PLOTHARC,
PLOTHARCCOLOR, PLOTHARCCOLOR3D, PLOTHYBRIDARC, PLOTJUMPS.

=
No= O

13 % Copyright @ Hybrid Systems Laboratory (HSL),
14 % Revision: 0.0.0.3 Date: 05/20/2015 3:42:00
15 %

16 % Check on Jjump conditions

17 % % E.g.,

18 % 1f (x(1) <= u(l)) && (x(2) <= 0) % Jjump condition
19 % v = 1; % report jump

20 % else

21 % v = 0; % do not report jump

22 % end

23

24 n = length(vs); % measured input size

25

26 tau_s = x(end); % timer state

27

28 1if tau_s>=0 && tau_s<= Ts

29 v = 0; % do not report Jjump

30 elseif tau_s> Ts

31 v = 1; % report Jjump

32 else

33 v = 0;

34 end

There are numerous practical examples of systems that can be modeled within the general model for
sample-and-hold feedback control defined above. For example, one “classical” example is the control of the
temperature of a room by turning on and off a heater so as to keep the temperature within a desired range;
see the model in . Another widely known example is the control of the level of a water tank.

[u]
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6 Further Reading

Installation files for the HyEQ Toolbox described in this paper can be found at MATLAB Central and at
the author’s website

https://hybrid.soe.ucsc.edu/software,
Also, resources and examples are shared by the HyEQ Toolbox users in the blog

http://hybridsimulator.wordpress.com.
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